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1. Introduction

SeaStar is supporting software for the DST comp-tilt Data Storage Tag.
SeaStar can run under Win98, Win 2000, WinXP, WinNT and Vista.
This manual takes you step-by-step through the program installation,
hardware connections and use of the SeaStar Program. New updates of
SeaStar will be available for free download at:
http://www.star-oddi.com/Online-Support/Software-updates/.

Please note that the downloaded file has to be installed into the existing
SeaStar folder. The update alone is not a complete program and therefore
will not work like that. Follow the instructions on the update website for
correct installation.

This manual guides the users of DST comp-tilt through the operation of
the recorder. Setting the operating parameters as well as data retrieval
requires access to a PC computer with a standard RS-232C serial
interface or USB.

DST comp-tilt is a compact microprocessor-controlled comp-tilt,
temperature and depth recorder with electronics housed in a waterproof

ceramic housing.

The sensors are located as shown on the diagram below.

Tilt

Pressure (depth) sensor

-

\ Temperature sensor

Compass

Figure 1.1 DST sensors

It is extremely important that the area is kept free where the pressure
sensor is, to allow free flow of water/liquid to the temperature and
pressure sensors. Please note that the pressure sensor membrane is
fragile, and objects should not be pressed against it, as it might cause
damage.
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Install

The installation program is on the SeaStar CD. Insert the CD into your

compact disc drive. To install the program, follow the automatic
InstallShield Wizard.

Follow the instructions on the screen. You will be prompted for a
directory name for your SeaStar program.

Uninstall

To uninstall the program, do the following:
1. Click on the Start button in Windows.
2. Go to Settings and Control Panel.
3. Choose Add/Remove Programs.
4. Choose SeaStar and click on Change/Remove, and ‘Yes to all’.
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2. Preparation

This chapter describes preparations that should be carried out before
connecting to the recorder.

Start SeaStar and the following window appears:

[®] SeaStar 4.3 - DST CompTilt - 10192 - C:\SeaStar\DST CompTilt\0192
File Edit Recorder Settings Wiew Window Help

I |Meas.seq‘no: 2 |On—|ine |Com1 | /J

Figure 2.1 SeaStar main window

Select recorder type

SeaStar is compatible with other Star-Oddi instruments. A recorder type
must be selected before connecting to the recorder. The default setting
in the software is set to Starmon mini as a recorder type. Change the
recorder type to DST comp-tilt by doing the following:

1. Choose the File menu and the New Recorder Type command.

2. Select DST comp-tilt as a recorder type.
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SeaStar - Select Recorder Type P§|

Available Becorders:

DST CompTitt -

Cancel

Figure 2.2 Select DST comp-tilt as recorder type

Before connecting to the recorder, it is important that the clock on the PC
computer is correct. This is important since the recorder automatically
downloads the PC clock settings.

Configuration of the communication port

It is necessary to define which serial port on your PC computer you will
use for connecting the Communication Box. This is done in the following
way:
1. Choose the Communication command in the Settings menu.
The Communication definition dialog box appears.
2. Select a serial port for communications.
3. Choose the OK button.

Communication Definition g@@

Select communication port :
' COM-1
~
" COM-3

Part enable / Power :
(+ OM
" OFF

oK

Figure 2.3 Communication port configuration
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To check which communication ports are available on your computer,
open your Device Manager. On Windows XP you can do it following way:
Control panel > system > hardware > device manager.

Under Ports you can view all available ports. Make sure that the port you
are intending to use is enabled: right-click on the appropriate port and
select properties. Under ‘Device usage’ it should state ‘use this device
(enable)".

Communications Port (COM1) Properties

General | Port Settings | Driver | Details | Resources

(3 Communizations Part [CORMT)

Device hpe: Ports [COM & LPT]
b anufacturer: [Standard port bypes]
Location: on Intel[R] ICHADO LPC Interface Contraller -

Device statuz
Thiz device iz working properly.

If wou are having problems with thiz device, click Troubleshoot to
start the troubleshooter.

Troublezhoot. .

Device uzage:

|Jze this device [enable]

l Ok ][ Cancel ]

Figure 2.4 Enable communication port

Using the USB serial converter

If you are using the USB serial converter you will need to install the driver
first that comes on the provided CD. Please, read the ,Quick Installation
Guide' booklet to get further instruction on how to proceed.

After you plug in the USB cable you will see a new communication port in
your device manager, called ,Prolific USB-to-Serial Comm Port'. Make
sure that the port is enabled and select the appropriate port in SeaStar.
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L Device Manager _.. __.EI | &|
File Action Wiew Help
& B X
+- i§ Computer ~
+|-age Disk drives j
+ § Display adapters
+ihy DVDYCD-ROM drives
+|-{idg Human Interface Devices
+-i=) IDE ATAJATAPT controllers
+-ig Kevboards
+- ) Mice and other pointing devices
+- 7 Moritars
+- B8 Metwork adapters
-1 5 Parts (COM &LPT)
(‘__‘f Communications Port {COM1)
S ECP Prinker Port (LPT1)
“__‘ui Intel{R) Active Management Technology - SOL (COM3)
Pralific USBE-to-Serial Camm Pork GEY]
+ ﬂ Processors
+-8), Sound, video and game controllers
+- by Swstem devices s
+ % Universal Serial Bus contrallers hd

Figure 2.5 USB communication port in Device Manager

10
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3. Communication Box

This chapter provides details concerning the Communication Box and
how to place recorder in the box prior to connection.

Communication Box

The DST Communication Box is a PC-RS-232C compatible
communication interface, specially designed to communicate with DST
recorders wirelessly via RF (radio frequency). A USB serial converter plug
can optionally be used with the Communication Box.

The Communication Box has three diodes:

1. Red - shows that power is fed from the power supply to the
Communication Box.

2. Yellow — shows that SeaStar has made connection with the box, DST
comp-tilt has been selected as a recorder type and that correct COM
port has been selected.

3. Green - shows that recorder is in correct position for seeking
connection.

Connect the serial cable between the serial port of the computer and the
Communication Box. Plug the power supply connection to a power-
socket. The voltage from the power supply should be set to 9V, although
there is no damage to use up to 20V. Before inserting the power plug
into the box, it is important to note that the polarity should be:

—(O+  (minus on the outside and the plus on the inside).

The polarity is usually shown where the arrows meet on the power plug,
and the power supply. After the power supply has been connected to the
Communication Box, the red light should be on. After SeaStar has been
started, the yellow light should be on (if correct COM port is selected).

The box will power the recorder while communicating with the PC. In

case the battery is dead, the PC and interface are still able to connect to
the recorder and retrieve data.

11
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Connection point

In order to get the green light, the red and the yellow light must be on.
The recorder is inserted into the hole of the box as shown in the figure
below:

DST comp-tilt

/

/ Communication Box

N

Figure 3.1 Inserting recorder into the Communication Box

If the recorder has been recording in the waters, then please wipe it dry
before inserting it into the box. The spherical end of the recorder faces
down and flat end faces up. Recorder is rotated until the green light
illuminates.

When green light is on, communication can be established with the
software. For best connection conditions, recorder is placed in the
middle of the area where the green light is on.

For our latest products we have added a mark on both the housing and
the Communication Box to help finding the right position. Simply turn the
logger until the small grey mark on top of the sensor meets the marking
that is drilled into the surface of the Communication Box.

If the recorder fails to connect, please refer to the ‘Troubleshooter’
chapter.

12
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4. DST comp-tilt

General description

The DST comp-tilt measures additionally to temperature and depth,
compass heading of the DST (with reference to the magnetic north) and
tilt in 3-D three directions (with reference to the Earth gravity). The
measuring parameters are measuring the magnetic field in two directions
in the horizontal plane to give the comp-tilt heading in degrees (°). The
diagram below shows the measuring directions of the sensor relative to
the DST housing. In this position the heading (nose of housing) is west
(270°).

Figure 4.1 DST Comp-tilt

The performance of the DST comp-tilt is optimal when it is placed in the
horizontal plane, the further the comp-tilt pitches and/or rolls from the
horizontal plane the larger the error reading becomes. However the 3-D
tilt measurements compensate for the pitching and rolling, minimizing the
compass heading error.

The recorder needs to be placed horizontally on the subject, having the
nose facing in the same direction as the subject is moving (for example if
the DST is attached to fish, the nose of the DST should face in the same
direction as the nose of the fish). Normally the two holes should have the
same distance from the flat plane and housing text (DST comp-tilt or
specified text) face up. A mark on the end of the recorder's flat end
should face directly up. The data are shown in degrees:

0° = North

90°= Easth

180°= South

270°= West

13
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Other measurements in between, like 45° would mean N/E etc...

In the SeaStar software you can define if the data point resolution of the
comp-tilt measurements should be 4 point, 8 point or 16 point degree.
This is defined under 'Settings - Preferences - Units'.

Hands on description

DST comp-tilt is calibrated at Star-Oddi, but it's possible that the sensor's
direction may differ slightly in other surroundings, including underwater
environments. Therefore it is recommended that the user performs
reference measurements at the beginning of a measuring period. For that
purpose, please synchronize your own clock with the PC computer's
clock, to see in which directions the recorder is placed at each time. If you
have a standard compass meter, it would be useful to do some
comparison measurements.

Also because the horizontal and vertical components of the Earth's
magnetic field vary considerably in different locations it is possible to
calibrate the compass in SeaStar, under 'Edit - Reconvert Definitions -
Compass Definitions' and put in an offset value for declination (more on
pages 47-48).

To understand declination it should first be realized that there are two
North Poles. There is a True Geographic North Pole at the top of the
world, and a Magnetic North Pole which is over 1,250 miles from the True
North Pole. A magnetic compass like DST comp-tilt always points toward
the Magnetic North Pole. Maps are oriented to the True North Pole. The
angular difference between True North Pole and Magnetic North is called
declination. Declination varies from O to 30 degrees in most populated
regions of the world. These declination values usually change slightly over
time, as the Earth’s plates shift. The actual value of declination can be
found on the internet'. This will be expressed as either a Easterly or
Westerly declination, depending on your location.

The date-time, latitude and magnetic field vector should be noted at
release and recapture point. That information can be put in the SeaStar
software under ‘Edit — Reconvert Definitions — Deploy/Retrieve Location’.
To correct/improve the tilt and magnetic field calculations the user should
enable that option. This will give more accurate compass and tilt data.

! The declination value can be found at www.ngdc.noaa.gov/geomagmodels/struts/calcIGRFWMM

14
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5. Using DST comp-tilt - Tutorial

This chapter guides users in 8 quick steps through the process of utilizing
SeaStar to set up DST comp-tilt prior to recording and data retrieval.

Step 1 - Start Program
Start SeaStar as described in chapter 1. Remember to carry out the
software preparation outlined in chapter 2.

Step 2 - Connect

Connect the Communication Box as described in chapter 3. Insert DST
comp-tilt into the hole in the box, and twist the recorder until the green
light illuminates on the box.

Step 3 - Connect to the recorder
Choose the Recorder menu and the Connect command. A window
appears with information on the recorder's mode, example:

Connection OK @

L] . .
The recarder is an-linel
The recorder waz in zleep mode

ok

Figure 5.1 Connecting to the recorder

Press OK. The Recorder is now on-line, as indicated at the bottom of the
SeaStar window.

Connection time registration

Each time SeaStar connects to a Recorder, the PC time and recorder
time is registered to a binary file, with a CLK extension. This information is
also saved to a text file with the extension CCT.

Another text file is created with the extension CCD, containing various
information, for example on previous connection and time comparisons,
depending on the status of recorder.

If a previous CCT file exists and the recorder was in sleep or slumber
mode, a PC vs. recorder clock comparison is calculated, indicating
difference in seconds and ppm.

15
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If the recorder was in measurement mode, then a drift calculation is
performed, based upon PC-time comparison to the recorder’s clock and
measurement sequence.

The RIT file contains partly the same information as the CCD file.

Upon retrieving date from a recorder and converting the data, the last
measurement retrieved time and the next scheduled measurement time is
compared to the PC time. The results are added to the CCD file and the
MIT file.

Note: If the retrieved number of data does not match the last measured
number of data, erroneous results are to be expected.

Step 4 - Set new measurement parameters
(If the recorder has already been set up to record data and you want to
retrieve data, go directly to step 6).

Choose the Edit menu and the New Measurement Sequence Definition
command. The following window appears:

Set New Measurement Sequence E@@

Set start time

Start date: 19/06/2009 =
Stark ime: Hour 8 : kin 40 :

Set measurement interval lime

0 -

Hours -

) -
Minutes 10 -
-
-

Seconds 0

Primary / secondary - definitior
* TD-CompTilt normal

" TD as primary

¢ CompTilt az primary

Secondary counter: 0 :

Walues allowed are 0,35,7.9.11.13 285

oeice M|
& Single mode
" Multi mode

[~ Save this NM5 definition as a Template [file]

Figure 5.2 Measurement sequence definition

16
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Select the start time of recordings (date-month-year, hours-minutes).
Set the sampling interval (hours-minutes-seconds).

With default settings, Temp-Depth (TD) and CompTilt will be recorded at
each sampling (TD-CompTilt normal). The user has the option to select
either TD or CompTilt as a primary sensor. The objective with this feature
is to save memory size, increase recording period, and get more data on
the sensor that is of more interest (primary sensor). In this case, a
secondary counter can be defined, which can only be odd numbers. If for
example CompTilt is selected as a primary sensor, and the number 3 is
defined as a secondary counter, then TD will only be recorded every third
time when CompTilt is recorded, and the majority of the memory is used
for CompTilt recordings. If CompTilt is set as primary and secondary
counter to O, then it is only making Comp-tilt recordings, even though the
first recording is always a CompTilt-TD measurement.

If the user wants to program several recorders with the same sampling
interval and start time, it is recommended to select Multi mode. By
choosing Multi mode, the settings are fixed; giving each recorder
connected to thereafter, the same settings. The recorders connected to,
following the first recorder, automatically get the same settings as the first
recorder. This saves time in the programming process. For programming
more than one sampling interval, please refer to chapter 9 ‘Multiple
Intervals’.

The three buttons Use Template, Use Sequence, and Previous are not
commonly used, but can be handy when wanting to use a previously
programmed sequence. To read more about templates see ‘Templates’ in
chapter 8.

After the settings have been selected, press the OK button.

Step 5 - Start a new measurement sequence

To set the recorder in Measurement Mode (start recording), choose the
Recorder menu and Start New Measurement Sequence command.

A window appears on the screen in order to verify the settings to be
downloaded into the recorder, example:

17
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Start New Measurement Sequence Activation E|
‘? Y
“‘-"4-/

The recorder’s hew measurement sequence zettings are:

Start time: 02/06/2009 14:31:50
teasurement interval [hms]: 00:00:10

| Ok | l Cancel

Figure 5.3 Start New Measurement Sequence
Press OK and the recorder will be in Measurement Mode.

NMS Calculation

Upon setting up a NMS the estimated measurement sequence is
calculated and memory and battery energy usage predicted. The results
are written to a text file, bearing the recorder name with a NMS extension.
If a recorder has not been selected then the file bears the recorder type
name, still the NMS extension.

The file is placed in the SeaStar\NMS directory.

An example of the *.NMS file is shown in fig. 5.4

C:\SeaStar\NMSAID192.NMS H=E3
Filename: C:%3eaftar\NMS\IOL19Z.NM3
deadtar 4.3

File creation Date & Time : 19/06/2005 09:58:538

Recorder type : DT CompTilt

Recorder wersion -]

Recorder numher = Inlsz

Recorder measures : Temperature, Pressure, Compaszs«dDTilt

Recorder memory(bytesmeasz.): 261575 F 20121

Measurement starts : 1970672009 10:55:00
Battery energy at start (%): 100.0

Memory full : 08/11/2009 04:38:00

After [(days:hours) : 139:17
In Cycle HEY

In sedquence HEY

In Interwval =1

In measurement : 20122
Total TD taken : 20122
Total CompTilt taken T 2Z01lzZz
Eattery uszed (%) : 16.2
Battery left (%) : B3.8

Figure 5.4 Results from NMS calculation

When starting the recorder in a NMS, the *.RDT file shows the sequence
settings, plus information on the sequence time duration and battery
usage (same as in the *NMS file).

18
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Step 6 - Retrieve data

Choose the Recorder menu and the Retrieve Data command. Data will
be uploaded from the recorder and presented in graphical and tabular
form.  With default settings, SeaStar automatically creates a sub-
directory in the Seastar directory, named DST comp-tilt. In the DST
comp-tilt directory, a directory named after the recorder’s serial number
(Qnnnn) is created. All files related to the recorder are automatically
saved in the serial number directory. The default data directory can be
viewed in the Settings menu, and Directories. The user has the option to
define a new data directory path if desired.

The data is retrieved in a non-destructive manner. This means that you
can repeatedly read the data without erasing it from the memory. Each
time data is retrieved, a new file will automatically be created. The name
of the data file consists of the measurement sequence number and the
serial number of the recorder. The recorder cannot be loaded with new
settings if it contains data that has not been retrieved. This is a safety
feature which prevents data from being accidentally lost. New recordings
overwrite previous recordings that have been retrieved.

Step 7 - Disconnect

After the recorder has been set up for measuring, it should be removed
from the Communication Box. If the recorder is not put in measurement
mode, it will automatically go into sleep mode when removed from the
box.

If you simply remove the tag SeaStar will still have the recorder in on-line
mode in the program and won't allow selecting another recorder or using
certain options. Select Recorder > Disconnect to go into off-line mode.

Step 8 — View data

If data is retrieved from the recorder, a new file will automatically be
created and opened in graphical and tabular form. To open existing data
files on the computer, choose the File menu, Select Recorder command,
and then the Select Measurement command. When a data file has been
opened, a new window appears with the data shown as a chart and a
table. The next chapter will describe in detail how to view and process
data.

19
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6. View Data

This chapter describes how to open a data file and the options available in
SeaStar for viewing the data.

Open Data

To open an existing data file that has already been retrieved, do the
following:

1. Choose the File menu and the Select Recorder command. When a
recorder has been selected, its serial number will be displayed in the blue
top bar of the software.

2. Select the data file by choosing the File menu and the Select
Measurement command.

The name of the data file consists of the measurement sequence number
(number of times the recorder has been set up to measure) plus the serial
number of the recorder. The ‘Measurement sequence no.” can also be
seen at the bottom in the SeaStar window. When the data file (.mid) has
been selected, the chart and data tables are opened. The following figure
shows a chart and data table which have been opened:

E=ll=HH& ChartEdit | Templates Hide Table

1101180 AT-R cconverted Meashiumber Time [rempecy|pepthimy] Tik-xe [ Ti-vee) | Tik-2(7) [romp He=comp.4p] A

L 450 21.9.200805:30:00 11,94 285 158 587 3,9 110 a0
T N 451 21.9.200805:00:00 12,06 23 159 s78  37 10 0
oo N 452 21.9.200805:30:00 12,19 z0z 164 S8 38 12 0
ooE e Fzo.00 N 453 21.9.2008 07:00:00 12,31 255 164 585 31,4 111 90
29,00 +- " ' 454 21.9.2008 07:30:00 12,41 2,59 15 57,9 32,6 116 90
28,00+ -1 - p1oeao B 455 21.9.2008 08:00:00 12,41 2,59 15 549 306 116 a0
2700 4-}- F15000 H 456 21.9.200808:30:00 12,36 258 146 583 324 115 a0
26,00 |-f- | 20000 B 457 21.9.200809:00:00 12,44 26 168 561 302 118 a0
2z00 1] i 458 21.9.200809:30:00 12,38 304 168 ST4 32,3 119 a0
24:00 i 250,00 : 453 21.9.2006 10:00:00 12,38 3,04 16,2 57,6 33,1 118 a0
200 | LM Fa00,00 N 460 21.9.2008 10:30:00 12,41 3,06 16 =8z 323 119 0
I 461 2192008 11:00:00 12,38 04 166 557 30,3 1 0

2200 - Faso00 —

b N 462 2192008 11:30:00 12,38 34 163 55| 32,3 122 0
21,00 - 400,00 N 463 21.9.2008 12:00:00 10,5 2,64 16,3 - 42 17 an
20,00 - Fasogo N 464 21.9.2008 12:30:00 8,29 294 198 385 4,5 121 a0
19,00 4 465 21.9.200813:00:00 9,02 285 192 - 41,1 135 a0

D5 | =00 H 466 21.9.2008 13:30:00 9,81 278 17,3 -6, 46,7 136 180
éw,uu il I-550,00 § O asr] o :00:00 286)  14] -349
% rs00 |- Ileone 5 1 468 21.9.2008 14:30:00 17,8 %0 195 180
v N 469 21.9.2008 15:00:00 22,6 90 253 255 270
(=1 | [ §50,00 H 470 21.9.2008 15:30:00 23,4 509 33,8 89 90
T | 70000 L 471| 21.9.2008 16:00:00 192 7 4R 52 a0
1300 F ki | 7000 N 472 21.9.2008 18:30:00 21,8 276 53,2 41 0
12,00 4|4 ' N 473 21.9.2008 17:00:00 195 273 5,6 43 0
11,00 4- 800,00 474 21.9.2008 17:30:00 223 ez 483 29 o
o d - U a0 o L 475 21.9.2008 18:00:00 2 23] 54,7 44 ]
soo J 4l oo 20 N 476 21.9.2008 18:30:00 191 6 452 24 [
a0l b N 477 21.9.2008 19:00:00 199 268 529 41 [
Fas0,00 478 21.9.2008 19:30:00 21 27 5,8 B [
L [— B 479 21.9.2008 20:00:00 195 215 546 39 [
8,00 -+ ' N 480 21.9.2008 20:30:00 0 283 53,9 34 0
500 -f- . b HHsaqpiosec [ 481 21,9.2008 21:00:00 193 283 46,1 2 0
400 - Hhoom [ 482 21.9.2008 21:30:00 187 273 53,9 ] o
spo bbb 1 Mr e H 483 21.9.2008 22:00:00 196 265 42,8 351 0
- - : N 484 21.9.2008 22:30:00 21,3 34 457 53 0
13.09 00:00 2009 00:00 27.0900:00 0410 00:00 485 21.9,2008 23:00:00 22,5 30,1 43,6 95 a0
Measurement fime: 11.8.2006 - 3.10.2008 - 3
Tirme-Window Statistics For Temperature(°Cy
Max: 30,62 at 22.09 14:00 Pin: 2,72 8t 01,10 11:30 Average: 13,42 u « > >

Meas.seq.no: 1 Fowon  [Comi

Figure 6.1 Chart and data tables of an open file
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Import

Data files from other recorders than DST can be imported into SeaStar
and viewed as charts and tables. The imported file must be a text file with
the extension DAT, and with SeaStar's conventional DAT file structure.
See more about data files and headers in the Appendix.

Buttons

When the chart is opened, buttons related to the chart are displayed.

B

Active Series List
This button can be useful when working with a multi-sensor recorder, in
order to select which parameters to display in the chart.

=1

Horizontal/Vertical Gridlines
These two buttons give the option of hiding/displaying the
horizontal/vertical gridlines in the chart.

==

Data Point Marker
This button gives the option of displaying/hiding data points in the chart.

Histogram
The graph can be shown as histogram, showing various data statistics.

H

Save Window Data

Retrieved data is automatically saved, but if changes are made with the
graph, for example with the time scale, the save button enables the user to
save the graph (as a DAT file).

Print
The chart can be printed. Please see chapter 7 for more detalils.
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Chart Edit
By clicking this button, the following window appears:

|- Series 1 Timeline - %@E Line: TimeLine
Temperature(=C)
PressurelBar) Farmat IF":'i”t ]
Tilk-%(=} .
Tilk-(=) Border...— | [ Dark3D Line Mode:
Tilk-2(% B s
Comp. Head(®) Calar .., [ Color Each [ Inverted
Camp. 4p(*)
Pattern. .. [v Clickable outline. .
- Chart
+|- Axis Height 30: |0 ill [v Color Each line
+- Titles
Legend Stack:  Mone 7 Shadow...
Panel
Paging Treat nulls:  Donk Paink - Gradient,. [ |
+-Whalls
Daka
o Tecle bt

Figure 6.2 Editing Chart

This button gives several options regarding the look of the graph. The axis
can be defined (max. and min.), titles and legend can be set visible. Under
‘Panel’ the color of background, borders and gradient can be selected.
Under ‘Walls - Back’ the colors and gradient of the graph itself can be
selected. The ‘Visible’ option must be enabled to activate the features.
The graph can be exported in formats as jpg, gif, bitmap, metafile, pdf, htm
and svg.

| Templates |

Templates

If the changes have been made to the graph under ‘Chart Edit’, it is
possible to save that template. It is also possible to load a previously
saved template.

Hide T akble |

Hide/Show table
The data table can be either displayed or hidden using this option.
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Using the mouse

Max. and min. values

Click once on any line in the chart, and the maximum and minimum values
for that line (sensor) are now shown. A straight vertical line should be
visible in the graph (to the left). By clicking on this line and holding the left
button on your mouse down, the line can be dragged through the chart
and the data table will scroll along with the position of the line.

Zoom

The chart can be zoomed in by holding down the left button of the mouse,
and using the cursor to create a box to the right, around the desired area
to zoom in on.

Scroll the chart

The chart can be scrolled upward, downwards and to the sides, by
holding down the right button of the mouse and moving the cursor in the
desired direction.

Go back to initial view

To go back to the initial view of the chart, simply hold down the left button
of the mouse and make a box to the left with the cursor. The position of
the box on the chart is irrelevant.

Change the axis
By double clicking on the X and Y-axis, the measurement time and

temperature/depth range can be changed.

Change the title
To change the title of the chart, double click on the title of the chart
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The View Menu

When a recorder has been selected, the files in the View menu can be
opened.

Data Trend and Table

This view is automatically selected when data is retrieved or a data file is
opened. If the chart is closed, but a recorder has been selected, this
command can be selected to view the chart. The software will open the
latest chart that was viewed for that recorder.

Recorder Information (RIT)
This is a text file containing basic information about the recorder, serial
number, production date, estimated battery life etc.

Recorder Calibration Information (RCI)

This text file contains information about the calibration constants of the
recorder, calibration range of the parameters. The range is both showed
as decimal values (DV) and unit values (UV). The survival depth of the
recorder is also shown.

Recorder Download Information (RDT)

This text file contains information about the measurement sequence that
was last downloaded into the recorder, including the start time, sampling
interval and the measurement sequence number.

Viewing text files
Under <View\Text files> the user can select a text file, via a file browser,
for viewing.
This option is meant to give the (advanced) user a chance to view files
that are not directly supported for viewing in SeaStar, but are a part of the
SeaStar documentation system.
The files that the file browser accepts must have the following extensions:
= TXT
Frequently, users copy SeaStar data to text processors and
spreadsheets, like Word and Excel, and later save the data as TXT
files for viewing in other applications.
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= INI
There are a number of INI files that SeaStar uses for store settings.
These files are described in the Appendix under ‘Information files’.
The latest members in the INI files family are the Template files.

= DAD
This is the original data file. It contains the raw data (in Ascii format)
retrieved from recorder. The DAD together with the MID are
converted to the DAT file.
A word of warning: The DAD file should never be tempered with, as
that might give cause to erroneous data conversion.

= CCT
Every time SeaStar connects to a recorder, the PC time and the
recorder’s clock data are stored in a <recorder name>.CCT file.

= CCD
Every time SeaStar connects to a recorder, the PC time and the
recorder’'s time are compared to the last CCT, if found, and stored
in  <recorder name>.CCD file, <measurement sequence
name>.CCD.

= NMS
Upon completion of a NMS editing session, estimation of memory
and battery usage is calculated and the results placed in a NMS file,
which is then displayed to the user.

SNMS LOG file

To improve the “Start New Measurement Sequence”, SNMS,
indication/registration of success or failure, a log file for each recorder
type is placed in the SeaStar directory.

The log file name, for DST comp-tilt, is DSTIL.LOG, i.e. the same naming
convention as for the type INI files.

Each time a SNMS is performed then the appropriate LOG file is updated.
The LOG file can be viewed via “View\SNMS Log file (LOG)”

In addition to the LOG file, if an error occurs during the SNMS, the MDD
file is created as a text file, with a description of what went wrong. This
MDD file is displayed as a clear message for the user as shown in figure
5.6.

Usually the MDD file is a binary file, and the MDT is created from the
MDD. If the SNMS is repeated successfully the MDD file is overwritten
and the MDT file created.
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Fecorder numher o Qoo27
Measurement sequence number @ &
Attenpted INMS Date and Tiwme: 3.12.20068 15:44:17

4 communication error occured when
transfering new settings to the recorder

Pleasze note that the recorder was NOT started !
Pleaze try again.

W

Meas.seq.

Figure 6.3 The MDD SMNS error message

Measurement Data

Measurement Download Information (MDT)

This text file contains information on data downloaded into the recorder
for the measurement file being viewed, including the start time and
sampling interval.

Measurement Information (MIT)

This text file contains information concerning the measurement upload
time, start date, start time and number of measurements in the
measurement data file.

Conversion Information (CIT)
This text file contains conversion information on the units and the data file
format.

Statistics in CIT:
The CIT, has been enhanced with more detailed information on the
converted data.

As can been seen in figure 6.4, the statistical data, that have been
tabulated, are split into two sections, the Unit values statistics and the
Decimal value statistics. Values are given for each parameter. The file can
be viewed under ‘View\Measurement Data\Conversion Information (CIT)':
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i) C:YSeaStar\DST CompTilt\0192)210192.CIT
Filename: C:}Seaftar\D3T CompTilt)IOLSZYEI019Z.CIT -~
Geadtar 4.3
Deszcription:
Recorder type : DET CompTilt
Recorder number : I0192
Recorder wersion ¢ 5 DM/CRCLE/4800
Recorder measures : Temperature, Pressure, Compasss3DTilt
Memory capacity : 201zo0
Memory capacity(Meas/Byte) @ Z01Z0 / EA1575
Measurement sequence number H
Conwertion mmber = o
Meas. start time[d.w.¥ him:s] @ 04,03.09 13:44:32
Time of conversion : 18/05/2008 10:37:01
Conwersion type : Upload conwversion
Calibration constants used i from MID-file
Huuwher of weasurensnts : 276
Total mesurement time : 0:0:53:2
Neasurements read from DAD 1124
Conwerted measurements : 1194
Data file settings
Temperature unit @ [°C) Celcius
Temwperature number of decimals : 3
No Temperature offset adjustment
Pressure unit : (bar) Pressure
No Pressure offset adjustment
Pressure number of decimals 3
Angle unit: deg. (")
Angle numb. of decimals : 2
No ingle offset adjustwment
Compass Heading unit : deqg. ()
Heading mamb, of decimals 1
No declination adjustment H "
b >

Figure 6.4 Statistics in CIT file

A one line description/comment is available for the user to fill out in the
Reconvert data menu. This description is placed in line two of the CIT file.

Out Of Range (OOR)

This text file lists all the measurements that were outside decimal value
calibration range, as well as the unit value range. If correction has been
performed according to the user definition, then the corrected values are
shown. See more about ‘out of range’ in chapter 8.

Binary Data (DAB)
This file contains raw data of the measurements
Calibration files are not calculated into the data.

in the data file.

View DAB files as trend

When converting the DAD -> DAT the DAB file is created simultaneously.
The DAB shows the recorder’s native data, i.e. decimal values in the range
0-4095. These values originate from the recorders 12 bit ADC (Analog to
Digital Converter).

It can be of interest to view the data in its native form, for example to spot
saturation/out of range intervals.

The DAB can be viewed graphically as a trend via:
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‘View\Data Trend and Table\Decimal (Binary) data (DAB)’

_@ =1 [ & chatedt Hide Table

218419DAB
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Statisics for Temperature
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Measseqnoi2  PowOn (Com3

Figure 6.5 DAB trended

ainssaig

[ [Nurbe]Time: Temp _[Press A
[] 6731 146006034210 242 329
[] 6732 1452008034211 | 2424 329
[] 6733 1462008034212 2424 329
[] 6734 146.2008034213 | 2424
[] ©735 146.2006034214 | 2624
»
[] 6739 1462008034218 | 2424 3280
[] 6740 1452008034218 | 2424 328
[] 671 145008034220 2424 329
[] 62 145008034221 | 2424 329
[] 6743 1452008034222 | 2424 328
44 1462006034223 2424 328
[| 6745 146008034224 | 2424 328
[| 6746 1462008034225 | 2424 328
[] 6747 1452008034226 2424 329
[] 678 1452008034227 2424 329
[| 6749 1462008034228 | 2424 328
[] om0 1es.005034228 2624 329
[] et res2008034230 2624 329
[] em2 1452005034231 2424 329
[] 673 1452008034232 2424 329
[] 674 1452006034233 | 224 323
[] e75 1462008034234 | 204 3080
[] e76 1462008034235 2424 329
[] e77 1462008034236 2024 329
[] o786 1462006034237 | 204 3080
[] 679 1462008034238 204 329
[] 670 1452005034238 | 2424 328
[] o1 146008034240 2424 329
[] o2 145008034241 | 2024 328
6763 1462006034242 2424 328
[] o764 1462008034243 2424 329
[] 675 146008034244 2424 329
[] o766 1462008034245 | 2424 328
[] o7 1452008034246 | 2624 3@
[] o768 1452005034247 | 2424 329
[] o9 1452005034248 2024 323
[] 6770 1462008034248 | 204 3280
[] 6771 1452006034250 | 204 3080
[] 672 145.2006034251 | 204 3080
[] 673 1452008034252 | 224 329
[] 674 145008034253 2424 329
[] 6775 145008034250 | 2424 328
[] o776 1452008034255 | 2424 3%
B777 1462006034255 2424 328
[] 678 1e6.008034257 | 2424 328
[] 679 146008034258 2424 329
[] 670 1452008034258 2424 329
[] oot 1es.2008034300 | 2624 3@
[] o2 1452005034301 | 2424 32
[] o783 1452006034302 2424 329
B34 1462006034308 2424 33V
< >
) >

SeaStar cannot view older DAB files, and will inform the user to that

effect, if an attempt to view an older DAB file is performed.

reconverting the data, a viewable file is produced.

Converted Data (DAT)

By

This is the text file for the converted data. The DAT file as well as the
other text files can be opened in other programs (Excel, Notepad, Word

etc.).

Time Synchrone Data (TSD) and Rate of Change (ROC)

If the TSD and/or ROC file creation has been enabled under the Settings
menu, then it's possible to view these files. More about TSD and ROC in

chapter 8.

More about files in the ‘Appendix’.
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Opening data in Excel

When retrieving data, the SeaStar software automatically creates a text
file with the data, called *.DAT. This text file can be opened in Excel and
in other programs.

Under the ‘Settings’ menu, ‘Preferences — Data File Format’, the default
factory settings is set to ‘joined date and time’. [f this option is not
disabled, the following is performed, for opening data in Excel:
1. Excel is started.
2. The *.dat file is found from ‘File/Open’.
3. Excel comes up with the ‘Text import wizard’. This is a three step
process:
a) No changes should be made in first step, so hit the next button.
b) ‘Text qualifier’ should be set as ‘None’. Hit the next button.
c) Column 2, that is date and time, is set as ‘Text. Hit the finish
button.
4. You can now create the graph with columns B, C and D.
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7. Printing

All charts and text files can be printed from the SeaStar software.
Choose the File menu and the Print command. If a chart is in the active
window, the following dialog box appears:

TeeChart Print Preview |'-_ E| [5__<|
Hi = hn deskjet 3400 Setup, ., Prink | Close
Crienkation:
" Parkrait

¢ Landscape

Margins (%)
5

Reset Margins |

[w iew Margins

Dekail:
More Maorral

[v Proportional
| Smooth

Figure 7.1 Print dialog box

Orientation
The chart can be printed in either portrait or landscape format.

Margins

By changing the margins, the chart’s length and width can be re-scaled.
The margins can be varied by either changing the numbers given for the
left, right, top and bottom margins, or by moving the margin lines with the
mouse by pressing and holding the left button as the lines are dragged.
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Move

When the cursor is located on the chart, a hand becomes visible. By
clicking on the graph and holding down the left button of the mouse, the
graph can be moved around the page to a desired position.

Detail

The size of horizontal and vertical gridlines as well as the texts on the X
and Y-axis can be re-scaled by using the scroll bar. The number of
gridlines is increased when the bar is moved to the left.
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8. Settings

This chapter describes the options in the Settings menu. These settings
are automatically saved when exiting the program.

Directories

The path definition can be set as Default SeaStar path structure or User
defined paths. Choose the Settings menu and the Directories
command. A dialog box appears:

Path Definition FEX

Set path definition az:

f+ Default SeaStar path struchure

™ Uszer defined pathz

Default SeaStar path structure

Data directony: C:ASeaStarsDST comp-tiltnnnn

Type directony: C:hSeaStar\DST comp-tilt

|Jzer path definitian

[rata directary |

KN

Description |
. P | e
& FeEEEzan]

L

QK | Cancel |

Figure 8.1 Directory path definition

Default SeaStar path structure

By choosing DST comp-tilt as a recorder type, SeaStar automatically
creates a ‘DST comp-tilt’ type directory in the ‘SeaStar’ directory that was
created when the software was installed on the computer. Upon
connection with DST comp-tilt, another directory is automatically created
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in the ‘DST comp-tilt’ directory, which is named after the serial number of
the recorder.

All data files and other files related to that recorder are stored in this
‘serial number’ directory. Each DST comp-tilt recorder has its own data
directory.

User defined paths

If this option is selected, the User definition data directory becomes
active. The data path/directory can be defined by the user. For defining a
path on the network, the particular drive must be mapped (under
Windows Explorer) in order to browse for the drive under ‘Add data path’.

Browse first in user directory

With default off, the user is first directed to the path where SeaStar was
installed, to look for the INI file. If this option is enabled, SeaStar will start
looking for the INI file in the user-defined directory. More information on
files and directories can be found in the Appendix.

Create recorder directories

This option is default on, and means that a recorder type and serial
number directory is created for every recorder connected to.
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Preferences
Units

By choosing the Settings menu, the Preferences command, and Units, a
dialog box appears:

Units g@@

Temperature units:

f¢ Celsiug ['C] Mumber of decimals{0-4]
¢ Fahrenheit ['F] 3
Fressure units
{+ Pressure Bar)
™ Depth [m] Murnber of decimals(0-4)
2

(™ Depth [fthrm]

" Pressure [pzi]

Tilt and Compass units are fixed Mumber of decimals: [0-4]
to degrees (-390 -> 90 / 360) 1

Compazs definitiorn

* 4 point compaszs " 8 point compaszs " 16 point compass

Cancel

Figure 8.2 The units dialog box

Select units

The user defines whether degrees Celsius or Fahrenheit are used as a
unit for temperature measurements. The pressure measurements can be
displayed as pressure (bar), depth (m), fathom (fthm) or PSI. Number of
decimals for the values can be selected. The comp-tilt heading is default
set to 4 point comp-tilt (N-E-S-W) but also possible to increase it to 8 or
16 point comp-tilt.

Data File Format

By choosing the Settings menu, the Preferences command, and Data
File Format, a dialog box appears:
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Data File Format @

Date format Date zeparatior
o Dot []
o dd mm yy
 mm dd py " Slash [/]
" Dash[-]
Time separatior Field zeparation
f* Colon[:] f* Tab
" Dot[.] " Space
Drate and time colurnn definition Select decimal point:
o Joined date and time f* Commal,]
" Seperate date and time " Dat[.]
Cancel

Figure 8.3 Data file format dialog box

Date format
The user defines whether the date should be shown as dd mm yy (day,
month, year), or mm dd yy (month, day, year).

Date separation

The user defines whether a dot, slash or dash should be used to separate
the date.

Time separation
The user defines whether a colon or a dot should be used for the time
separation.

Field separation

For the text files created, the user defines whether a tab or a space should
be used to separate the fields.
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Date and time column definition

If data is to be exported to other programs, it is recommended that the
date and time be joined in one column.

Select decimal point

The user defines whether a comma or period is used for the values
displayed in SeaStar and for text files that are created.

Measurement Interval

The default setting in the software is set to ‘Single interval’, as most users
utilize. By choosing ‘Multiple intervals’ the software enables programming
of several different sampling intervals, enabling memory saving efficiency.
By choosing the Settings menu, the Preferences command, and then
Sampling Intervals, the following dialog box appears:

Measurement intervals @

Mumber of meazurement inkervals bo uge

" Multiple intervals

1] 4 Cancel

Figure 8.4 Measurement intervals

By choosing ‘Multiple intervals’ the effects are shown in the dialog box
that appears when you choose the New Measurement Sequence
Definition command under the Edit menu. More details about multiple
intervals in chapter 9.
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Connection

Choose the Settings menu and the Connection command. A dialog box

appears.
Connection Options E]

[v Perform CRC test when retrieving RID

[ Automatic data retriesval upon connection

Cancel

Figure 8.5 Connect and retrieve data options

Perform CRC test when retrieving RID

The CRC test is a safety check performed by the software when retrieving
Recorder Information Data (RID). If the CRC test is not successfully
carried out, it means that some errors have occurred in the transfer of files
or constants, between the recorder and the computer. If a CRC test
failure occurs, the user is notified. This option is enabled by default but if
disabled there is a risk of errors in the constants.

Automatic data retrieval upon connection

By enabling this option, the software will automatically check for data in
the recorder upon connection. [f this option is not enabled, data retrieval
is done manually by choosing the ‘File’ menu, and ‘Retrieve Data’
command.
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Retrieve Data

Choose the Settings menu and the Retrieve Data command. A dialog
box appears:

Retrieve Data Options @

Retriere number of data according to:

f Last zaved number of measurements / byte: 58 / 87

" |lzer defined number of data [byte]

Recorder capacity measurements / byte: 43476 / BRZ15

[w “iew Data Trend [*DAT] after Conversion

[vw “iew Data Trend [*DAT] after Measurement Sequence Selection

] 4 Cancel

.................................

Figure 8.6 Retrieve Data Options

Retrieve number of data

With default settings, the software retrieves the last measurement
sequence recorded. The user has the option of retrieving older data that
is still in the recorder’'s memory. By choosing the User defined number
of data, the number of measurements retrieved from the recorder can be
set. Memory capacity is 20,120 measurements per sensor compass, 3-D
tilt, depth and temperature (261,575 bytes). When retrieving data, it is
optional to view the Data Trend after conversion.

As the complexity of measurement intervals give incoherence in the
calculation from measurement number to the number of data byte to
retrieve, the user has the option to define number of bytes to retrieve.

Also when not online working with measurement data, it is optional to
view the Data Trend after a Sequence Selection.

If for some reason or another it becomes necessary to retrieve data more
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than once or even several times, the previous DAD and MIT files are not
overwritten before a backup has been made. The backup files are in the
same directory as the “original” or the last DAD file.

A backup number system is in use that marks the first retrieved file as
number one, the second number two etc. The number sign #, is used to
identify the backup up files.

Thus if a data file has for example the name 256M1106.DAD then the
backup file, that was the first retrieval, gets the name 1#25M1106.DAD,
and the 25M1106.MIT file that is associated with the DAD file, is backed
up as 1#25M1106.MIT.
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ReConversion

Choose the Settings menu and the ReConversion command. A dialog
box appears:

ReConversion Definition g@@

v Make Numbered copies of ReConversion Files

[v ‘iew Data Trend [F.DAT] after BeCorversion
[ “iew Time Synchrone Data [* TS0 after ReConversion

[~ “iew Rate Of Change data [*ROC] after ReConversion

Figure 8.7 Reconvert menu

With all the options in SeaStar, the user may want to do a lot of
reconverting (<File\Reconvert Data>) on data files after defining the
preferences; changing units, data formats, OOR settings, TSD settings,
ROC settings, offset settings and converting different sections of the data
file, all of which result in numerous files. To ease the task of remembering
settings and results and/or renaming and copying files, a backup system
of reconverted files has been implemented.

A reconvert number is now associated with each sequence. This number
is saved in the recorder’s INI file and updated each time a reconvert is
implemented. A copy is made of the DAT, CIT, DAB, OOR, TSD and the
ROC files with the reconvert number attached to the filename.

Thus if a data file is for example named 5Q1024.DAT, then after the first
reconvert, a copy of the DAT is named 1-5Q1024.DAT, and the same
naming convention is applied to the other files.

Each time data retrieval is performed, a subdirectory, which name is the
sequence number, is created in the data directory, where a copy of the
“original” DAT, DAB, CIT and OOR files is placed. These files have a “0-*
in their names. All the reconverted files are placed in the sequence
directory. The reconvert number system is optional, and the user can
disable it in the reconvert menu. When the reconvert number system is in
use, and when viewing trended reconverted data, the reconverted
“backup” file is displayed, thus eliminating the need to close the “last”
converted trend data window.
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Out Of Range

If measurements are outside the calibrated range, they are less accurate.
The out of range measurements (if any) are shown in the OOR file (View —
Measurement Data — Out Of Range Data). For example when depth
measurements are outside the first calibration range (at very shallow
depth or in air) the data may look strange and the user may want to set
those data to O.

Choose the Settings menu, Out Of Range - UV and DV definition
command. A dialog box appears:

Set TD Out Of Range (OOR) Parameters E@@
Decimal values (1-4094) Unit values
Min Max Min Max
Temperature ‘]0 j |4090 g |‘5 j |55 j (-10 - 120 *'C)
Pressure |10 3| 4020 2 o 3 300 2| (o - 3000 m)

Default

Presvious

Cancel ‘

Figure 8.8 Set ranges for the parameters

The Unit Values (UV) ranges can be set, eliminating all values that are
outside the calibration range.

Decimal values

Decimal Values (DV) are raw measurements, sometimes referred to as
binary data. The decimal value is between O and 4095, which is the
range for the 12 bit AD converter. The decimal values are the recorder’s
calibration range. The user should not define the decimal value range,
unless he has obtained these values for that particular recorder from Star-
Odd..

Unit values

The decimal values are converted to Unit Values (UV), for example a
decimal value of 2000 could give 20°C. The user can select a specified
range for the parameters. If unit values in the data are outside the
measurement calibration range of the recorder, the user has the option to
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set a max. and min. range for these unit values. After selecting the unit
value ranges and pressing the OK button, the following window appears:

OOR Correction §|
DV-Carrection L-Correckion
e Mo Correction f* Mo Correckion
" Lask walue i Last Yalue
£ Max/Min DY-limits " MaxMin LN-limits
............ I:I K Car":e| |

Figure 8.9 Out Of Range (OOR) Correction

If no values have been selected for the Decimal Value (DV), ‘No
Correction’ should be selected for ‘DV-Correction’. If Unit Values (UV)
ranges were specified, the user has two options:

1. Last Value: Change the out of range measurements to the last
value that was recorded before the out of range measurement was
recorded

2. Max/Min UV-limits: Change the out of range value to the max/min
unit value as specified earlier. In this case the software will know if
the value is under the minimum or maximum limit.

After the correction has been made (after pressing OK), the data needs to

be reconverted under ‘File — Reconvert Data’, and data will be changed
accordingly. More about reconverting in chapter 11.
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Time Synchronous Data (TSD)

Choose the Settings menu, TSD definition command. A dialog box
appears:

Time Synchronous Data Settings E|

[ Make T5D file when converting DAD - = DAT

Sample Interyval
f« 1 Hour

10 Minutes
{5 Minutes
{1 Minute

[ Inchude emply cells

.................................

o] 4 Zancel

Figure 8.10 Time Synchronous Data Settings

If the user wants to time synchronize two or more data files, it is possible
to select three options: 1 hour, 10 minutes, or 5 minutes. The restriction
is that the sampling interval selected must be greater than the initial
interval, and it must also be dividable by the initial interval. For example, if
the initial interval was 15 minutes, only the 1 hour option can be selected
for time synchronous.

If the ‘Include empty cells’ is enabled, the data tables will be empty for
those measurements in the original file that are not to be shown.

If the user wants to activate this feature, the ‘Make TSD file when
converting DAD-DAT' must be enabled. For changing the current
measurement file with one of the three intervals, the data must be
reconverted by ‘File — Reconvert Data’.
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Rate Of Change (ROC)

This new feature gives the user a chance to see how fast the signal is
changing, i.e. the estimated velocity of the signal. This applies to all
measured parameters. The ROC is calculated via a two point numerical
differentiation:

ROC= (P2-P2)/(t2-t1)
P: Parameter expressed in a user defined unit
t: Time (hour, minute or second)

The way the ROC is set up and viewed is very similar to the TSD.
Under ‘Settings\ROC’ the ROC options can be set:

Raie Of Change Data Seitings g]

[v Make ROC file when converting DaD-=0AT

Time Unit Selection
" hour

f* minute
i sec

" nounit {constant = 1)

|v Units are expressed with a prefix milli (E-3)

Cancel

Figure 8.11 ROC definition

The ROC is only computed when a DAD->DAT conversion is performed,
and when the user wishes. The time units are selectable as hour, minute
or seconds. For small changes it can be convenient to express the ROC
as a mili (10°) unit, for example if the depth is in meters (m) then
millimeters are expressed as (mm).

The ROC can be viewed as a trend under ‘View\Data Trend and

Table\Rate Of Change (ROC)" or as tabulated data via
‘View\Measurement Data\Rate Of Change’.
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Chart

Title

To change the title of the chart click on the title name. A dialog box
appears:

Chart Title

Enter Mew Chart Title:
1C123

(8] 4 Cancel

Figure 8.12 Chart title dialog box

The chart is automatically assigned the data file number as a chart title.
To change the chart title, enter a new text string and press the OK button.

Time axis

To change the time scale of the chart, click on the X-axis scale. A dialog
box appears:

Axis Settings E]E]

L= [F eazurement date: 040342009

Scalez
[w Automatic

o 04/03/2003 1437

[Ehesesi
= 040342003 13:58

0k ‘ Cancel |

Figure 8.13 X-Axis settings dialog box
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By disabling the Automatic option, the minimum and maximum time values
become active. By clicking on the Change buttons for the maximum and
minimum values, the time range can be specified. For creating (saving) a
new data file (DAT) with a new specified time scale, please refer to
chapter 11 (Reconvert). By enabling the Automatic option, the
measurement time will go back to the initial range.

Value axis

To change the scale settings for the value axis, click on one of the Y-axis
scale. A dialog box appears:

Axis Settings D@@

Scalez
[w Automnatic

v

_Changz e |
7 Auto Chang=Hin | 0

(] ‘ Cancel |

Figure 8.14 Y-Axis settings dialog box

By disabling the Automatic option, the minimum and maximum
measurement values become active. By clicking on the Change buttons
for the maximum and minimum values, the range to be shown on the chart
can be specified. By enabling the Automatic option, the measurements
will go back to the initial range.
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Chart Editor

The Chart Edit button (on every graph) gives access to the Chart Editor, a
multi-option menu, now with a Tree View interface, as can be seen in
figure 8.15.

There are four main branches on the tree.

1. Series
2. Chart
3. Data

4. Export

The tree menu gives access to the same features as the tab menu
described in the user’s manual. Most of the changes invoked are viewable
immediately.

All format and style changes made to the chart, are lost if the data are
viewed again or “Reconverted”, as the *.DAD and the *.DAT file are not
affected by changes made to the chart or the database.

1. Series:
The Series window offers the same features as the “Active Series List”
button.

- Series L
TEMREFEUFE(TC] | | s
Fressure(Bar) %@ V — R +
DTN | oM
::E ﬁg § %@ [v — Pressure(Bar) fddd
k- &dd...
Tilt-z¢=) bz ¥ — Tik-e)
o
Carnp,Head(®) iﬁé R
Comp. 4p(*)
TimeLine bz ¥ — Ti-z(e) Title. ..
B Cha::. w [ Cormp.Head({)
+- fxis
+|- Titles bz ¥ Comp.4p(®)
Legend v S Chan
v TimeLine oo
Panel %@
Paging
+- Walls
Daka
o Tocle b

Figure 8.15 Chart Editor
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When a particular series is selected, like the Temperature series for
example, a two tab menu is revealed, as seen in fig. 8.16, where the user
can “format” each series, and set “points” in the graph. The tab “Point”

—|- Seties b

— Temperakure(*C) - ﬁ}_’f Line: Temperature(®C) —
Temperature(=iC)
Pressure(Bar) Fabimel: IP':'i”t ]
Tilk-{=) )
Tilt-y (= Border..— | [ Dark 3D L= MD.dE'
Tilt-2(=3 Ll
Comp.Head(®) Color,..Jll | [ Color Each I
Comp. 4pl®)
Timeline Pattern... [v Clickable outline. .
—|- Chart
+- fxis Height 300 |0 ill [v Color Each line
+- Titles
Legend Stack:  Mone - Shadow,..
Panel
Paging Treat oulls:  Dont Paint - Gradient.. [ |
+-Walls
Data
il Tacle b

offers visibility to points as the “Data Point Marker” button on the graph,
plus formatting of the points.

Figure 8.16 Format series.
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2. Chart
The chart branch has six sub branches,
» Axis
* Titles
* Legend
* Panel
= Paging
* Walls

Axis:

There are 8 axes in a normal SeaStar chart, the number in use depends
on the recorder type. The Left Axis and Custom 1 axis are always in use,
the latter is reserved for the timeline.

Tilk-3{=)
Tilk-(=) _
Tilt-2(2) Options \Minimum ] Macximurn ] Increment ]

Scales | Tide | Labels | Ticks | Grid | Position |

Comp.Head(®) [ Automatic
Comp. 4p(®)
TimeLine v Visible L

-1 Chart
- Axis [ Logarithmic

Right &xis Log Base: I
Top Axis
Bokkorn Axis
Depth Right
Depth Top
Cuskarn 0
Cuskom 1
Cuskom 2

al TiHar

Close

Figure 8.17 Axis formatting

Figure 8.17 shows a six tab Axis menu. There are numerous options,
some of which can drastically change the behavior of the graph. The
Minimum and Maximum tabs give options similar to the menu offered
when clicking an axis on the graph, the ticks tab gives access to enable
and disable gridlines, just as in the “Horizontal gridline” and “Vertical
gridline” buttons in the graph.
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Titles:

The Titles menu shown in figure 8.18, gives access to 4 tiles, each title a
multi line text window, which can be positioned anywhere on the chart.
There are multiple formatting options, six tabs, for each title.

TimeLing
- Chart
= Axis
Left Axis
Right Axis
Top Axis
Baktom Axis
Depth Right
Depth Top
Cuskomn O
Cuskam 1
Cuskom 2
+
Legend
Panel
Paging
+)- Walls

Lk

Title hd

Shyle lPDsitiun ] Farmak ] Eorder ] Text ] Gradient ] Shadow ] Picture ]

Iv Wisible v Adjust Frame Alignrent:  Center i

Texk:

ZI01920AaT

Edit. ..

Close:

Legend:

Figure 8.18 Titles menu

The legend menu (see figure 8.19) gives the user an option of showing a

series legend.

The 8 tab menu gives options in styling positioning and formatting the

legend.

TimeLine
—I- Chatt
=] Axis
Left Axis
Right Axis
Top &Axis
Bokbam &xis
Depth Right
Depth Top
Cuskom 0
Custorn 1
Cuskomn 2
+]- Titles
Legend
Panel
Paging
+- Walls

Lok

Style lF‘ositiu:un ] Symbols ] Title ] Format ] Border ] Text ] aradient ] shA | ¥

[ wisible Legend Style:  Automatic -
Text Style:  Left Walue -

Wert. Spacing: [0 ill

[~ Inverted

[v Font Series Color

Mo check boxes hd Dividing Lines, .. ‘

Close

Figure 8.19 Legend menu

51



User’s Manual SeaStar graphic supporting software

Panel:
The Panel menu (see figure 8.20) offers panel format options. Images,
pictures and icons can be imported onto the panel as a back image.

TimeLine | Color lBDrders] Margins] Gradient I Shadow I Image]
—|- Chart

= Axis Calor...[]
Left Axis

Right Axis [~ Defaulk
Top Axis
Bottam &xis
Depth Right
Depth Top
Custom 0
Custom 1
Custom 2
+- Titles
Legend
Panel
Paging
+- \Walls
In ]

|v Back Image Inside

Close

Figure 8.20 Panel menu
Paging:
With the Paging menu, shown in figure 8.21, the data series can be
chopped into pages, with a user defined number of points per page. Only
one page is shown at a time, and the user can scroll through the pages
via the page buttons, that appear (are enabled) on the chart to the right of
the Edit Chart button, when paging is selected.
Paging can be useful for viewing distinct time periods, one at a time, days
or hours for example. No offset is offered and sampling periods and start
time can limit the usefulness of this option.

+._Edit chart X]

TimeLine -

—|- Chart Points per Page: [0 j‘ rd

= Axis

Left Axis
Right Axis
Top Axis
Boktarm Axis
Depth Right
Depth Top
Custam 0
Custam 1
Custam 2
+- Titles
Legend
Panel
+- wtalls
Lk

Iv Current page Legend
Iv Scale Last Page
[ Show Page Mumber

[ Auto scale axis

Edit...

Page 1 of 1

Close

Figure 8.21 Paging menu
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Walls:

TimeLine " - ' |
C chart v Wisible Walls Size: |0 =
=] Axis
Left i
| ot Ao ]nght ] Bioktarm ] Back, ]
Right: Axis Calor... ]| [ wisible
Top Axis
Boktom Axis Border..., —| [
Depth Right
Depth Top Patterrn... [~ Auko Hide
Custorn 0
Cuskomn 1 Gradient... ] [~ Transparent
Cuskomn 2
+- Tites Position: g =1
Legend Skark; |0 jl e o —
Panel - =1
Pading end: oo j Transparency: |0 =
e alls
Cizk= o8 i

Figure 8.22 Walls menu

The walls menu, as seen in figure 8.22, gives access to configuration of
four walls, but as SeaStar charts are default defined as 2D, only the
“Back” wall is visible.

The Walls menu, has similar options as the Panel menu, when defining a
pattern, via the “Pattern...” button, as seen in figure 8.22, an image can
be imported and placed on the wall. In fact, as the Back Wall lies “on top”
off the panel, a pattern or an image can enhance an image on the panel,
or the image on the panel can be seen through the wall with the
Transparency option.
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3. Data

In the data menu, seen in Figure 8.23, gives the user access to the
database, upon which the chart rests. Here text labels can be set to each
measurement point. Changes can be made to the time and measurement
values. Changes made to the data, are included when the data is
exported, but if the data are viewed again or “Reconverted” all changes
are lost, as the *.DAD and the *.DAT file are not affected by changes
made to the database.

s Edit chart X
L'?Ft F\xisl e — Temperat —Pressurel —Tilk-g{=y A
o P A
Bothom Ais o [0 13:55:00 009 13:58:00 0009 13:58:00
Depth Right 1 109 13:59:00 0109 13:5%:00 0
Depth Top z 109 13:59:01 0009 13:59:01 0
custom O 3 109 13:59:02 0009 13:59:02 0
custom 1 4 109 13:59:03 0009 13:59:03 0
Custom 2 5 109 13:59:04 0009 13:59:04 0

+- Titles & 109 13:59:05 0009 13:59:05 0
Legend 7 109 13:59:06 0009 13:59:06 0
Panel & 109 13:59:07 0009 13:59:07 0
Paging ] 09 13:59:05 0009 13:59:08 0
+- Walls 10 109 13:59:09 0009 13:59:09 0
11 109 13:59:10 0009 13:59:10 0 A
+- Taaols £ >
Expoart w - - A :q X qi'l

Figure 8.23 Data menu.
4. Tools
Under 'Tools' you will find several options to customize the setting of the
cursor and the appearance of the graph, such as page numbering, font,
font size etc. To active/deactivate the chosen setting check/uncheck the
'Active’ box on top of the first page of this menu.

+ Edit chart 3
Comp.4p(®) ~ : o
TimeLine fdd... ‘ Delete ‘ v fdive +
=|- Chart
+- Axis A Cursor Series: TimeLine hd
+- Titles Page MNumber
Legend Aec Rectangle e lSnap | Mouse |
Pan,al Mark. Tips Pemn... —
Paging —
+ - Walls Style:
Data )
L Wertical -
Eursol:j X Hariz, Size: Wert, Size:
age Mumber I—J I_;l
Rectangle o I=T| 0 =Tl
Mark Tips Scope Size: Scope style:
Export I I =1 [T -

Figure 8.24 First page of Tools menu
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5. Export

Under the Export menu, three tabs offer as many menus for saving data as

* Pictures.

= Native (data)

= Data (file)

Pictures

Left Axis
Right Axis
Top Axis
Eakkom Axis
Depth Right
Depth Top
Cuskom 0
Cuskomn 1
Cuskomn 2
+- Titles
Legend
Panel
Paging
+-Whalls
Daka
+- Tools

Format

as Metafile
as Bitmap

as JPEG

as GIF

as PDF

as VML (HTM)
as SWia

Picture lNative] Daka ]

Options I Size ]

v Enhanced

Copy

Save... Send... |

Close

Figure 8.25 Export menu: Picture

Figure 8.25 shows options when saving the chart as a picture to a file, or
copy the picture to the clipboard. There are seven format possibilities.

= Metafile
= Bitmap
= JPEG

= GIF

= PDF

= VML

= SVG
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Native
The Native menu, see figure 8.26, data is saved as “Native” *.tee chart
files. Import of these files is not supported in SeaStar at the moment.

Left Axis *| picture Native | pata |
Right fxis
Top Axis [v Include Series data
Boktom Axis
Depth Right Farmat:
Depth Top {* Binary
Cuskom 0 ~ Text
Cuskom 1
Cuskom 2 -
+- Titles o
Lagend [ Eile size: 7
Panel
Paging
+- Walls
Crata
+- Tools
— Save. .. Send. .. |
w

Figure 8.26 Export menu: Native

Data
Data can be exported to files in four formats, see figure 8.27.
= Text file (.txt)
» XML (.xml)
» HTML (hml)
= Excel (xls)

Left Aixis *| Picture ] Mative Data
Right Axis
Top &xis Series: anludg:
Bottom Axis {ally - ™ F‘Dfnt Index
Depth Right . N [ Poink Labels
Depth Top ;Erma ' v Header
Custam 0 o T [~ Paint Colors
Custom 1 " wML
Cuskam 2 i HTML Table Delimiter:
+]- Titles  Excel Tah - I—

Legend
Panel Text Quates:

Paging
+- Walls
Data
+]- Tools

— Copy Save... Send. .. |

Close

Figure 8.27 Export menu: Data
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There are four Include options:

Point Index:

The point index is the same as the measurement number, but offset by -1,
as it starts in O instead of 1.

Point Labels.

If the user has added text labels to points in the DATA menu, these can
be included.

Header

The same headers as are in the DATA menu.

Point Colors.

This option is not relevant in SeaStar.

Another method for exporting is to use the Alt+PrintScreen keyboard
buttons to copy an image of the SeaStar window to the clipboard,
thereafter to paste it to another Windows application. When a dialog box
is open, then only that frame is copied to the clipboard.

To copy a part of a data file, for example from a DAT file, then highlight the
part you want to copy and use the Ctrl+C keyboard buttons to copy the
data snippet to the clipboard. Then use the paste-option in another
Windows application to transfer the data from the clipboard.

Filename: C:%SeaStar\D3T CompTiltiT0192410192.RCT

(&l C:\SeaStar\DST CompTiltu0192110192.RIT

3
creation Date & Time: 19/06/2003 10:30:03
type : DST CompTilt
mber : 10192
unber i1
ate[ddimmiyy] : 20:02:08

Aubient pressure (uBar): 987
Pressure Calibration Temperature referance {"C): 0.00

_Ii

(1, %) decimal limits used:

| [Meas.seq.no: 2 londine [Coml | A

Figure 8.28 Highlighted text to be copied

57



User’s Manual SeaStar graphic supporting software

Timeline

The timeline is a graphical viewing aide. Every time a file is loaded for
trending, an extra time value is calculated for every measurement point.
These time values form the Timeline. The Timeline is an extra series that
follows the rules of the other measurement series. When the graph first
appears, the Timeline is inactive.

By selecting the Timeline in the Series List (see fig. 8.29), the Timeline
becomes visible as shown in figure 8.30.

Series List g@@

@ v — Pressure(Bar) L
W — Tilt[")

P ¥ — T2

iz Comp.Head[")

%’éﬁz{ ~ Comp.4p(]

w [~ — TimeLine

Figure 8.29 Timeline selection

=1 =| ]

e pea— Numbe|Time [Temer o Depthim)] A
3000 SO61 2272005200000 113 26
2500 SO51 2272005210000 1224 26
i F‘** 5081 22.7.2006 22.00:00 12,03 )
2800 I 2 SIM 2272005230000 1231 1.9
27,00 5121 237.2005 1268 22
H ’—l B | 5141 2372005000000 1287 2
00 ,J \ f\ 5161237.2005020000 | 1305 2
=4 210
2500

51611237.2005 03.00:00 13.02 22

2,00 r—M \2“1’/ i

23,00 0

5201 237 2006 04:00:00 1287 22
5221 23.7.2006 05.00:00 128 2
5241 23.7.2005 060000 12.68 21
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20
S 2372005080000 1A 24
2.0 ‘ ‘ = 05 5301 227,205 09.00:00 14 2
2000 - - 5371 2372005100000 1032 21
B em J ‘ 531 2372005110000 1076 23
T ‘ hJ 204 5361 23.7.2006 12.00:00 10,73 24
3 1800 237.2005 13.00:00
170 5401 237.2005 140000 02 a7
g ’_l 3 5421 2372005150000 11 34
1800 = 5441 227,205 16:00:00 REIEY]
15,00 el 5451 237.2005 17:00:00 11562 35
5481 237,205 18.00.00 128 28

14,00 £

il
U

5501 23.7.2006 19.00:00 13,02 32
5521 237 2005 20.00:00 1373 33
5541 23.7.2006 21:00:00 1418 a8
5561 237.2005 220000 14.34 25
5581 23.7.2008 23.00:00 14,16 21
5601 24.7.2005 1413 24

13,00

1200
LD [ [ &
e ey

om0 | ’—‘ / = 196
/vj 195

L
.
e
=~
=
L
==
=

5621 24.7.2006 01:00:00 1434 14
5641 24.7.2006 02.00:00 13,73 EX]

I

800 N } w’\ SEE1 2472005030000 1391 2
700 1 194, BEST 24.7.2005 04:00:00 14,04 2
S s 5701 2472005050000 | 1361 47
G 5721 24.7.2005 06:00:00 13,05 21
19.07 00:00 2607 0000 02.08 00:00 5741 2472005 07.0000 | 1256 26

Measuremert time: 12.7 2005 - 28 2005 v

Statistics for Temperature{ T}
Max: 2361 ot 27.7.2005 12:00:00 Min: 6,07 at 13 72005 17:00:00 Average: 15,35 ] | m

Meas.seano: 1 PowOn (Coml

Figure 8.30 Timeline on a graph showing “Day of the year”
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The Timeline is defined under Settings\Preferences\Timeline.
There are several options for the Timeline, as can be seen in fig. 8.31.

Timeline Definition

Define Timeline

i+ Day of the Year (1-3b65)
" Month of the year {1-12)
" Week of the year (1-52)
" Day of the month (1-31)
" Hours of the Day (0-23)

Cancel

Figure 8.31 Timeline options.

There is no need to reconvert the data, as every time a data file is loaded,
the Timeline is calculated in accordance with Timeline settings. The
Timeline is not a part of the *:DAT or the *.TSD files, but if the data is
exported (see the Export section), then the Timeline, if selected, will be
included. Thus, the Timeline can also be used for statistical purposes.
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Templates

There are two scenarios where templates come in handy:

1. When many recorders are programmed with the same settings
(multi mode), and circumstances are in a way that the user cannot
complete the setup of all the recorders in one session, and he has
to exit SeaStar (to continue later).

2. When the user wants to reuse, partly or completely, presumably a
complex and/or lengthy measurement setting.

Save a template

The user can now, when editing New Measurement Settings (NMS), save
his work by enabling “Save this NMS as a Template (file)" option (see fig.
8.32), before acknowledging OK from the Edit NMS menu. Having
selected this option and the NMS are OK, the user has an option to write
a description for the template (see fig. 8.33). Canceling this option
cancels the ‘save template’ operation. The template is an INI file and
saved in the SeaStar\NMS directory. The name of the file is
MST<date><type letter>time<Interval mode>.INI.

Set Mew Measurement Sequence g@@

Set gtart time

Start date: 10/06/200% ~
Start tirne: Hu:uur|8 j Mir |15 j

Set meazurement interval time

0 -

Hours -

Mirutes 10 :

0

Seconds

Set Mode Lze Template

(* Single mode
Use Default

" Multi mode

i

Prewvious

[~ Save this MMS definition as a Template [file]

Fig. 8.32 Template options in Edit\New Measurement Sequence
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Save NMS as Template

Template Name: MST10062009U1506025]

Template Description: |

1] ‘ Cancel ‘

Figure 8.33 Saving NMS as a Template

Use a template

Templates can be retrieved at a later time to be used directly or modified.
The list of templates is kept in the SeaStar\templets.ini file.

As can be seen in fig. 8.32 there are three buttons in the Edit NMS
window, the top button is used for retrieving a template.

As can be seen in fig. 8.34, templates are selected via template name or
description. Parallel to selecting a template, descriptions can be edited
and eventually templates deleted.

The recorder type and interval type, which the template was based on, are
visible for each template.

Select Template E@@

Template list
Interval Type Primary Recorder Type

Templst name | M5T18082009C11003301 ~|

D escription |U - Mo description j

Edit description
Delete templet

Cancel ‘

Figure 8.34 Template selection

Templates can be used across recorder type boundaries and interval
types.
Things to keep in mind when selecting a template are:
= Single interval templates converted to a multiple interval NMS. All
seven intervals are the same.
= Multiple interval templates converted to a single interval NMS, set the
interval as interval one.
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= Start time in the past is not allowed as will be apparent when exiting
the Edit NMS window.

= Some recorder types are less compatible than others, an example of
that is a DST milli template converted to a DST GPS NMS.

After having selected a template the user is returned to the edit window. If
the selection is not as what the user expected the “Previous” button will
return the previous setting.

The user has one more option to quickly set up the NMS. The button in
fig. 1, marked “Use Default”, will return default NMS settings. The button
can have four descriptions and return four different settings depending on
the status of recorder and measurement selection.

1. Use Default: No recorder selected

2. Use Recorder: Recorder selected but not a measurement sequence

3. Use Sequence: Measurement sequence selected

4. Use Online: Recorder is on-line
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9. Multiple Intervals

SeaStar has the option for setting up more than one sampling interval
within a measurement sequence. Reasons for wanting multiple intervals
can be to save memory, but still be able to have frequent measurements in
between. This may be the case with fish tagging, when frequent
recording is wanted in a specific period in the fish life cycle. If you want
to run on a single interval the whole recording period, this option is not
selected.

By choosing Multiple Intervals (under Settings-Preferences-
Measurement Intervals), multiple interval setup is activated. Thereafter,
choose the Edit menu and New Measurement Sequence Definition
command. The following dialog box appears:

Set New Measurement Sequence @
Silie s [T —— Interval sequence
Start date: 18/06/2008  ~ & Single mode 1 1 :

Use On-Line
Start ime: Hour 11 : Min 8 : " Multi made i 2 2 :
Previous
3P =
teasurement Interval types 4 4 -
Secondary -
Typenr.  Hours Minutes  Seconds  Mumber of meas.  Primary /Secondary Counter 1 "
1 F AP Afe 3 [ 3 Meeme 3 FY s
2 |0 j |20 j |0 j |12 J |EnmpTi|tasprimary j |3 g & 2 =
3 |‘1 j |0 j |0 j |8 j |TD—CompT\|tnormaI j |0 j 7 ’ =
4 |[j j |5 j |U j |5U j |TD-C0mpT\ItnormaI ﬂ |0 j 8 N =
g |[j j |[j j |][j j |3[j|j[j J |TD-E0mpT\ItnormaI j |[j g 9 ! =
6 [ 2P 20 2 [ew0 2 [owiwma = [ 3 102 =
7 |0 j |0 j |]0 j |‘}‘02 j |TD—CompT\|tnormaI j |0 j g =
1224 2
131 2
[ Save this NMS definition as a Template [file]
14 )2 3

Figure 9.1 Set new measurement sequence (with multiple intervals)

Start time
The user defines the date and time when recordings should start.
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Measurement interval

The sampling interval (time between measurements) is defined. Any value
from 1 to 99 seconds, or 1 minute to 24 hours with increments of 1
minute. Up to 7 different sampling intervals can be selected. If seconds
are used as sampling interval, the multiple of the sampling interval and the
number of measurements must be dividable by 60.

Number of measurements N1-N7

The user defines the number of measurements to be recorded within each
sampling interval. A value from 1 to 60000 must be set. Please note that
an inital measurement is taken at the defined ‘start time’. This initial
recording is not counted as a measurement for the ‘Interval 1’ number of
measurments. For example if the recorder should measure every hour
from midnight to ten o’clock (00:00 — 10:00), then the number of
measurements defined should be 10. Please note that only this one
measurement at the ‘start time’ does not count as a measurement for the
intervals. In this case, the first measurement counted for the ‘Interval 1’ is
at 01:00, and the last measurement is at 10:00, and then it shifts to
another interval.

After taking one measurement at the ‘start time’, the recorder will start on
the first interval in the sequence and take the number of measurements as
defined. After taking the measurements on the first interval, it will
automatically shift to the next interval etc. The sampling intervals and
number of measurements will recycle until memory is full, or until
connection is made with the recorder through a PC computer.

Sequence 1-14

The interval sequence must be filled out. As shown in figure 10.1, the
user selects to use intervals 1-6 for the recordings. Another example:

If two of the first sampling intervals are used, the sequence should be 1,
2, 1, 2 etc., meaning that the recordings shift between the first and the
second intervals, recording the defined number of measurement for the
first interval, and then shifting to the second interval taking the number of
measurements defined. The shifting between the intervals repeats until
memory is full, or until connection is made through a PC computer.

Primary/Secondary

With default setting, both Temperature-Depth (TD) and CompTilt is
recorded at each sampling interval (TD-CompTilt normal). The user has
the option to select either TD or CompTilt as a primary sensor for each
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sampling interval. The objective with this feature is to save memory size,
increase recording period, and get more data on the sensor that is of
more interest (primary sensor).

The secondary counter is only meaningful if a primary parameter has
been selected. The secondary counter defines how frequently the
secondary parameter is saved along with the primary parameter. [f for
example Comp-tilt is selected as a primary sensor, and the number 3 is
defined as a secondary counter, the TD will only be recorded every third
time when CompTilt is recorded. If the value is O (zero), the recorder is in
principle a Comp-tilt only, except the first measurement is always a TD-
CompTilt measurement.

There are restrictions on the secondary counter settings when multiple
intervals are defined. If a primary parameter is selected and secondary
counter is O then the ‘Number of meas.’ for the primary counter must be
an even number. If a primary parameter is selected then the ‘Number of
meas.’ must be dividable by the secondary counter, and only odd numbers
(0,3,5,7...255) can be used as a secondary counter.

The Use Template can be used if older definitions have been saved by
enabling the ‘Save this NMS as a template (file)'. That way it's possible to
get templates that have been set up in the past. With the Use Sequence
button it is possible to get same settings as from other recorders, by
browsing for their serial no. By hitting the Previous button the settings go
back to previous, before changes were made.
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10. Reconvert Data

In SeaStar you have the option of reconverting data that has already been
retrieved. After re-defining parameters, the data is reconverted by ‘File —
Reconvert Data’. The main reasons for reconverting data are:
e Adjust the center point for the pitch and roll
measurements.
e Shift pressure/depth values according to a reference
meter, to increase accuracy.
e Adjust measurements that are outside calibration range.
e Incorrect PC-time at measurement start time.
e Need for temperature or pressure/depth unit alteration.
¢ Need for data file format alteration.

Data Reconvert Definition
Under the Edit menu and Reconvert Definition, choose the Data
Definition command, and the following dialog box appears:

Data Reconwversion Definition g@@

Set reconversion measurement sequence start-time Time linear adjustment

" Mo Linear Time Adjustment

Chart date: 0032009 - " Linear adjustment time [min)

Tirme zpah [dayz)
Start time: Hour 13 *| Min 58 -

In reconversion use measurement intervals from In reconversion use constants from
L ' @+ MID file
+ Interval definition in MID file
_— " RID file
" Current new measurement sequence definition
" RED file
Convert number of data according to: Out Of Range Decimal Yalues Settings

& . .
e et (n s DD e &+ Full scale (Mo boundaries)
" User defined number of data

From measurement numnber: " User definition

Ta measurement number:

Commen

0K

Figure 10.1 Reconvert data definition
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Set reconversion measurement sequence start-time

If the user notes from retrieved data that the PC date and clock were
incorrect when measurements were started, it is possible here to specify a
new start date and start time.

In reconversion use measurement intervals from

The measurement interval is either the interval settings as shown in the
measurement (MID) file, or if that interval is incorrect, a new and correct
sampling interval is specified in the ‘New Measurement Sequence
Definition’ command in the ‘Edit’ menu.

In reconversion use constants from

The user can choose to use calibration constants from:

MID file. This option should normally be selected, as it contains
information on the constants from the measurement sequence.

RID file. The recorder information file contains the same calibration
constants as the MID file, except if it has been re-calibrated. If it has been
re-calibrated, and the user wants to use the new constants on older
measurements, the RID option should be selected.

RBD file. This option rarely needs to be selected. If the constants from
the MID and RID file are corrupt, the user should contact Star-Oddi for an
RBD file.

Convert number of data

The user can reconvert all the data in the last measurement sequence, or
define the number of measurements to be reconverted. The user has the
option to define what measurement range should be reconverted (for
example to exclude data points when the recorder was above water).

Time linear adjustment

The real time clock inside the DST has an accuracy of approximately +/- 1
minute per month. This slight variation might accumulate over time and
influence the measurement results. To correct the gradual time shift first
check ,linear adjustment time" then type in the time offset value and the
length of the measuring period.

Out Of Range Decimal Value Settings

Measurements that are outside the calibration range are inaccurate, and
may give erroneous results. The out of range (OOR) measurements can
be seen in the OOR file. The user has the following decimal value out of
range detection options when reconverting:
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Full scale (no boundaries). This means that literally no ‘out of range’
detection will be made.

User definition. With this selection the range definition under ‘Settings -
Out Of Range - DV definition’ will be used. This option is selected when
the decimal values (DV) are not available in the RID file. This would
normally require the user to contact Star-Oddi for the decimal values.

RID values. The calibration decimal range is given in the RID file. This is
the default option and should normally be selected.

If an RBD file exists in the \Seastar\RBD folder, then SeaStar recognizes

this file as a primary source for DV calibration range. In this case, the
fourth option appears and is set as default.

Temperature Definition

Under the Edit menu and Reconvert Definition, choose the Temperature
Definition command, and the following dialog box appears:

Temperature Reconvertion Definition Q@@

Temperature offzet adjustment
f* Mo offset adjustment

(" Offget adjustment value [m°C)

]9

Figure 10.2 Temperature offset correction menu

Offset Adjustment

When recorders are used over a long period of time, the temperature
measurements can start to deviate from correct values.

When checking older recorders, it has come apparent that the error in the
measurements is mainly due to an offset. Some users feel they can benefit
from an offset correction option in SeaStar, for example when a recorder
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has been in the water for a long time and is later tested to show an offset.
The offset is defined in m°C" (please note that 1°C equals to 1000 m°C).

Pressure Definition

Under the Edit menu and Reconvert Definition, choose the Pressure
Definition command, and the following dialog box appears:

Pressure Reconvertion Definition E@@
[ Dizable temperature carrection in pressure calculation
Preszure offzet adjustment Preszure linear adjustment
f* Mo offset adjustment ¢ Ma linear adjuzstment
(" Offzet adjustment value [mBAR] "~ Linear adjustrent value [mBAR]

Time zpan [days
f* Subtract the value pan [days)

" Add the value . .
" Megativ slope corection

{* Positive slope corection

-

Linear estimation outzide calibration range
[ Uze linear estimation outzide calik
[ Uze at next data retrieval for this recarder

Mate: This overnides 00R  comection definition

[ Perform fised temperature comection

e

IIIK‘

Figure 10.3 Pressure reconvertion definition

Disable temperature correction in pressure calculation

In case the temperature sensor is malfunctioning in a way that it will
indicate very high temperature values, it will offset the pressure
calculation. An automatic temperature correction is set by default in

* 1000 m°C = 1°C
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SeaStar. To turn off this feature, check the box next to ,Disable
temperature correction in pressure calculation®.

Pressure offset adjustment

The user can increase accuracy of pressure/depth recordings by finding
an offset value, which is the difference between a recorder’s depth value
and a reference meter’s value. Once the offset point has been set in, the
data can be reconverted, and all pressure/depth recordings shifted
according to the value defined (in mbar).

In cases where a drift has occurred with the pressure recordings, the
pressure data can be corrected if the user has a known reference point
for correcting the data. To find the offset value, the recorder should be
deployed in water, at a known depth (preferably >2 m depth), or placed
along with an accurate reference depth meter, where a reference point
can be taken. Once the offset value has been found, the offset pressure
value is put in the window shown above. The offset value can either be
subtracted or added to the pressure values.

When using 9.81 as g, the coefficient for converting cm into mbar is
1.019", If the ‘Use at next data retrieval for this recorder’ is enabled, the
offset value is fixed for that particular recorder, and future data uploads of
the recorder will use the offset value defined, for shifting the pressure
data. The offset value will apply only to that particular recorder, and other
offset values can be defined for other recorders.

Pressure linear adjustment

Aging of the pressure sensor can result in an offset of the measured
pressure values. To correct these offset values you can select a linear
pressure adjustment. Check ,linear adjustment value“ and fill in the
pressure offset value (difference between expected value and real value at
the end of the recording period) and the length of the measuring period.

Linear estimation outside calibration range

The pressure sensor tolerates a significantly higher pressure than its
calibration range. If the recorder is exposed to higher pressures than its
calibration limit it will result in erroneous data. By choosing this option you
will receive more adjusted values. Please note that since these values are
outside of the calibration range an exact adjustment is not possible, this
feature is mainly for estimation purposes.

* For example 100 cm = 101.9 mbar
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Depth calculation
For converting the pressure units to depth, the standard for the
acceleration of gravity is 9.81 (1 bar = 1000 mbar = 9.81 m), but it can

optionally be set from 9.78 to 9.83, depending on the gravity in the
different areas of the world.

Pitch & Roll Reconvert Definition

Under the Edit menu and Reconvert Definition, choose the Tilt
Reconvert Definition command and a dialog box appears:

Pitch & Roll Reconvert Definition

Angle offset adjusktment

[ Mo angle offset adjustment

Pitch
Offset adjustrment {me)(d MewTilk Range Values
& add MIN I8
" Subtract %:(1-32767) 1263 - 2738 e
Y1 (1-32767) 1260 - 2721 ¥
Roll-angle 2 (12787 {30 x 7o >

Offset adjustment (me)/0

f« Add
(" Subkrack

| Calibration walues From recorder |

Z-angle | Last defined values |

Offset adjustment (me)0 | IUse Last Conwversion Skatistic values |

{+ Add

" Subkrack
[ Use ak next daka retriewal for this recorder

[ Use at next data retrieval for this recorder

(0] 4 | Cancel

Figure 10.4 Pitch & Roll Reconvert Definition
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As the ‘No angle offset adjustment’ is disabled the above box appears.
The X, Y and Z angles can be adjusted. The offset value can either be
added or subtracted.

Normally the ‘No new range’ is enabled and not configured by the user

unless with consultation from Star-Oddi. The purpose of this feature is to
put in a new range when recalibrating the X and Y axis of the compass.

Compass Reconvert Definition

Compass offset adjustment

Under the Edit menu and Reconvert Definition, choose the Compass-
U,V command and a dialog box appears:

Compass Reconwvert Definition E|

Angle offset and Origo adjuskment

[~ Mo Angle offset adjustment [ Mo Mew Range
Compass Heading angle Mew Compass Range Yalues
MMIN [ax
Offset adjustment (<) |0
1 A 1 A
I {1-32767) ¥ ¥
i+ Add
™ Subtrack Y (1-32767) 1 g 1 g

[ Use at next data retriewval For this recorder

alibration walues from recorder |

Last defined values |

Use Last Conversion Skakistic values |

[ Use at next data retrieval For this recorder

[ Use Tilk to correct Compass values

Ok | Cancel

Figure 10.5 Comp-tilt Reconvert Definition
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As the ‘No angle offset adjustment’ and ‘No new range’ is disabled the
above box appears. The Compass heading angle can be adjusted. The
offset value can either be added or subtracted. Although the DST comp-
tilt is a two channel magnetic measurement device, the software converts
the values into a single heading value. The heading value shows the
Magnetic North.

In order to change the heading value into True Geographic North it is
necessary to put in an offset adjustment for declination. The declination
varies between regions but it is possible to see the declination in each
area on the internet’. It is recommended that the user makes reference
measurements of the comp-tilt heading prior to a study.

The performance of the DST comp-tilt is optimum when it is placed in the
horizontal plane, the further the comp-tilt pitches and/or rolls from the
horizontal plane the larger the error reading becomes. If it is shown that
the recorder has not been mounted in a 0°C horizontal position it is
possible to put in an approximate offset value based on the tilting of the
DST housing.

Deployment-Retrieve Locations

Under the Edit menu and Reconvert Definition, choose the
Deploy/Retrieve Location command and a dialog box appears:

Deployment and Retrieval Locations g@@

Deployment Retriesal

Date: Haour Date: Haur

Min Min
Bozizoos  ~| |0 S0 2 D2A02/2008  ~ =

Sec Sec

Ceg Min Ceg Min
Lakitude: |64 j ‘7 J ‘U j Latitude: |U j ‘O g |U j

Magnetic fisld vector (nT): |23 79 = Magnetic fisld vector (nT): |22 2 -

[ Use Position to correctfimprove Tilk and Magnetic Field calculations

(o] 4 | Cancel |

Figure 10.6 Deployment and Retrieval Locations

% The declination value can be found at www.ngdc.noaa.gov/geomagmodels/struts/calcl GREWMM
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Before releasing the DST comp-tilt the user should note down the release
time and date, latitude and the magnetic field vector. These information
should also be obtained upon recapture of the DST comp-tilt. To
correct/improve the tilt and magnetic field calculations the user should
enable that option and insert the information on time-date, latitude,
magnetic field vector, both for release and recapture of the recorder.

Reconvert data

After acknowledging the offset adjustments, the data need to be
reconverted, for the adjustments to be effective: <File\Reconvert Data>.
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11. Recorder Modes

In this chapter, the three operational modes of DST comp-tilt are
described, that is the PC Mode, Sleep Mode and Measurement Mode.

PC Mode

If the recorder is in the correct position in the Communication Box, and by
choosing the Recorder menu and the Connect command, the recorder is
put into PC Mode. At the bottom of the SeaStar window, the text On-
line is displayed, indicating that the recorder is on-line and in PC Mode.

While in PC Mode, the recorder will remain in an active listening stage.
The communication protocol is a simple master/slave arrangement, in
which the recorder is the slave. The slave will perform every command
the PC issues, and after execution of a command, it will return to listening.
When the recorder is connected to the PC, it is powered by the PC, and
not taking energy from the battery inside the recorder

Sleep Mode

The user receives the recorder in Sleep Mode, but it can easily be
awakened by the Connect command in the Recorder menu. If the
recorder is not set in Measurement Mode, it goes into Sleep Mode when
the recorder is removed from the Communication Box. When the
recorder is in this mode, less energy is depleted from the battery.

Measurement Mode

The recorder is put into Measurement Mode by choosing the Recorder
menu, and Start New Measurements Sequence. The recorder starts
recording measurements according to the start time (date/month/year)
and sampling interval (hours/min.) defined by the user.

When the memory is full, the recorder shifts automatically into Sleep

Mode. If the recorder is still in Measurement Mode upon connection
through a PC computer, it stops recording and is put into PC Mode.
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12. Memory Organization

The memory capacity in DST comp-tilt is 20,000 measurements for each
sensor. Data is kept in an EEPROM memory and will not be lost if the

battery fails or expires. The memory of the recorder is organized as
shown in the figure below:

Data memory

-
\

A

Settings —=

Unused memory/

N7 e Old recordings

Figure 12.1 Data memory organization

When data is retrieved from the recorder, the following occurs:

1. The computer retrieves the data from the recorder and writes the
data to the computer’s hard drive .

2. The recorder has stopped recording, but still holds the recorded
data.

When new settings are sent to the recorder, the following will occur:
1. New settings are sent to the recorder.

2. The data memory pointer is reset to the beginning of the data
memory and starts to write over older recordings.

The organization of the memory is now as follows:

Data memory

-
~

\/

Settings —=

Unused memory/
Old recordings

Figure 12.2 Data memory with new settings
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Appendix
Directories and Files

Directory structure

The user can choose between SeaStar’s default data directory structure
(path) or define his own data path. As the SeaStar program is a multi
recorder type program, the directory structure branches from the directory
where SeaStar is positioned down to type directories, i.e. Starmon mini,
DST comp-tilt etc. From there it branches again into recorder directories,
named after the serial numbers of the recorders, designed to hold data for
each individual recorder (data directory). All in all it is a three level
directory structure.

An example of this directory structure with DST comp-tilt is:
C:\Seastar\ The installation directory (SeaStar.exe location)

C:\Seastar\DST comp-tilt\ The type directory for DST comp-tilt
C:\Seastar\DST comp-tilt\l2018\  The directory for the 12018 recorder

When a new recorder type is selected in SeaStar (File — New Recorder
Type), the directory for that recorder type is created. When connecting to
a recorder for the first time, SeaStar creates the recorder directory,
named after the serial number of the recorder.

Information files

SeaStar uses information files to store and retrieve settings. There are

two types of information files:

1) The type-INlI files, (for example DSTx.ini for DST comp-tilt).
The information type files are all in the installation directory, they
contain information on specific settings for each type. The type-INI
files are:

StarmonT.ini Starmon mini
DSTm.ini DST milli
DSTu.ini DST micro
DSTc.ini DST centi
DSTs.ini DST CTD
DSTg.ini DST GPS
DSTx.ini DST pitch & roll
DSTq.ini DST compass
DSTi.ini DST comp-tilt
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2) The recorder-INI files, for example 12018.ini contains settings
information and data file positioning for the 12018 recorder. The
recorder-INI files are located in the appropriate type directory, i.e. all
the Qnnnn.INI files are in the ‘DST comp-tilt’ directory.

Files locations

As stated previously, the type-INIl files are placed in the ‘Seastar’
directory, and the recorder-INI files are placed in the recorder type
directory. All other recorder and measurement related files created by
SeaStar, are placed in the appropriate recorder’s directory. For example:
C:\SeaStar\DST comp-tilt\[2018\ is a directory for the 12018 recorder
and all files belonging to 12018 are placed there.

If the user whishes to use his own defined data path, for example
C:\Data), then all the files for all the recorders, except for the INI files, are
placed there. If the user has enabled the “Create recorder directories” in
the user path definition, individual recorder directories, irrelative to type,
are created under the user defined path, for example: C:\DATA\I201 8\ for
the 12018 recorder. The 12018.ini file (located in the C:\SeaStar\DST
comp-tilt\) contains the path to the C:\Data\l2018\ directory, and all files
related to the 12018 will be placed in that particular directory.

Browsing for a recorder

When browsing for a new recorder from the ‘Select recorder’ under the
files menu, the default method is to find a recorder-INI file in the type
directory. The INI file will then point to the data directory (the recorder’s
directory). If the user has enabled the “Browse first in the user directory”
in the user path definitions, the search starts in the user defined directory,
where a *.RID file must be selected.

Recorder related files
Every file that is recorder related has the following name format:
Xnnnn: The name is the serial no. of the recorder

Ext Description File type
RID Recorder information data Binary
RIT Recorder information text Text
RBD Recorder backup data Binary

RDD Recorder SNMS® download information data ~ Binary
RDT Recorder SNMS download information text Text

* SNMS: Start New Measurement Sequence
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The recorder ID (RIT) can at a later time be opened, and the related
measurement data can be viewed, printed and reconverted. The RDD,
RDT and DIR are download information files, created when a new
measurement sequence is started.

Measurement related files
Every file that is specifically measurement related has the following name

format:

mmmXnnnn: The name is the measurement number + serial no.

Ext Description File type
MID Measurement information data Binary
MIT Measurement information text Text

MDD Measurement download information data Binary
MDT Measurement download information text Text
CIT Measurement conversion information text Text

DAD Measurement Data Binary file Binary
DAB Measurement Data Binary file Text
DAT Measurement converted data Text

The MID, MIT and DAD files are created upon measurement data retrieval
from the recorder. The DAB, DAT and CIT files are created when
converting the data. The MDD and MDT are download information files
and created when a new measurement sequence is started.

Data files
Upon data retrieval, three main data files are created.

The *.DAD file

This file is the raw data source file. The data is in mixed binary form. The
user cannot access this file in the SeaStar program. When converting
these raw data into measurements, the *.MID file is needed. The result
from the conversion are two data files, the *.DAB and the *.DAT.

The *.DAB file

This file contains sequential binary representation of the data in columns.
The first column is the measurement number. The other columns contain
the measured parameters in a binary form.
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The *.DAT file

This is the actual result file, where the measurements are converted to
their natural units and timed. This is a text file with columns. The first
column is the measurement number, the second column the date and the
time, depending on the set-up. The third column is the time or the first
measured parameter, depending on set-up. The following column(s)
contain the converted measured parameters with units and number of
decimals according to set-up. Number of parameters can range from 1-3,
and number of columns 3-6 accordingly.

Data header

The *.DAT file contains a data header, which is a detailed description of
how the *.DAT file is configured. This feature is used by SeaStar when
graphically representing the data, and is practical if the user wants to
import the data into other applications or databases. Most of these
descriptive items are derived from the ‘Settings’ menu and the recorder
type definition in the ‘File’ menu.

Each header item is contained in one line, and all header lines start with a
# (bookmark) and a number. Then follows a description of the header
item, and then 1-4 directives, all separated by tabs. Eventually a comment
trails the directives, preceded by a ; (semicolon)
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Troubleshooting

Connecting to the recorder

In order to be able to communicate with the recorder, the three lights on
the communcation box need to be lit. The red light is the power, the
yellow light is the PC communication, and the green light is the recorder
communication.

No red light

1.
2.

Check if the DC power supply is plugged in.
Check if the polarity of the connector is correct. The plus should be
on the inside and the minus on the outside, +O)-

No yellow light

1.

2.
3.

4.
5. Check if the power on (PowOn) indication is shown at the bottom

Check if the correct recorder type has been selected under the
‘File-Recorder Type' menu.

Check if the red light is on.

Check the cable connection between the PC and Communication
Box.

Check if the correct COM port has been selected (see chapter 3).

of the SeaStar window.

No green light

1.

2.

3.

Check if the red and yellow lights are on.

Check if the voltage selection on the AC/DC adaptor is set to 9V or
higher (220V AC).

Check if the recorder is inserted correctly into the hole in the box.
The spherical end should face down.

Insert the recorder into the hole, and rotate until stable green light
comes on. If necessary, remove recorder from box and repeat the
insertion and rotation of recorder in the box.

Lift the recorder a few mm up in the box, hold it for two seconds
and put it down in the box again.

Unstable green light

1.

2.

Try rotate the recorder in the hole in the box, until green light
becomes stable.

If using a laptop, make sure that the DC power supply for the
laptop, is kept as far away as possible from the Communication
Box.
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3.

If out on sea, the recorder may be move around in the hole. To
immobalise the recorder in the correct position, try using a slip of
paper, and squeeze it down the hole, alongside the recorder.

If the recorder comes with a plastic tube attached, make sure that
the tube goes all the way through the hole on the bottom of the box,
so that the recorder is placed on the correct level for
communication.

Communication errors
All three lights on the box are on.

1.

2.

Check if the voltage selection on the AC/DC adaptor is set to 9V or
higher.

Most probable cause is that, although the green light may seem
stable, the communication link is weak. Try to rotate the tag slightly
in the hole, and try to connect again. Repeat if necessary. The
recorder should be rotated to the center of the stable green light
range (see chapter 4).

. If using a laptop, please make sure that the power cable/DC power

supply are located as far as possible away from the Communication
Box and the communication cable.

Make sure that no electrical devices/power sources are close to the
communication cable/box.

When trying to connect to recorder on a moving boat, the recorder
may move around while trying to connect, and causing
communication errors. Put a piece of paper at the sides of the
recorder in the box. This will keep it from moving.

If a ‘Device Error’ is reported upon connection, please check if the
SeaStar program has been opened more than once. This error can
also occur if a different program is open, and is using the same
communication port as SeaStar.

CRC error

The CRC test is a safety check performed by the software when retrieving
the Recorder Information Data (RID). The CRC is a register in the RID
file, which is calculated and placed in the recorder’s RID, when starting up
a new measurement sequence. When retrieving the RID from the
recorder, SeaStar calculates the CRC from the retrieved data, and
matches it against the recorder's CRC register. If they do not match, a
CRC error is reported.
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The reason why a CRC error occurs, is most likely due to bad
communication condition. Check the point above, under ‘Communication
errors’.
It is possible to disable the CRC check while connecting. This is done
under ‘Settings — Connection’. Normally, the CRC should not be
disabled, but the following scenarios are an exception, where CRC check
can be disabled:
a) A communication error occured while connecting. Please check the
5 points above before disabling CRC check.
b) A communication error occured while inititating a new measurement
sequence.
c) A communication error occured after data retriaval, while updating
status in the recorder.
d) A communication error occured while putting the recorder to sleep.
e) A communication error occured while updating status in the
recorder upon a POR (Power On Reset) error detection. When
connecting to the recorder and POR error is detected, a new status
is initiated in the recorder and the RAM data is reset.
f) Repeated CRC error occurs, and the above does not apply/has
been checked. This may though produce errors in the RID file,
which again may produce errors in the conversion of data.

Disable CRC check:

1. Go to ‘Settings — Connection’, and disable the ‘Perform
CRC test when retrieving RID.

2. Try connect to the recorder ‘Recorder — Connect'.

3. If connection is OK, then examine the RIT file for possible
error. These possible errors may manifest themselves as a
very high (>E20), or very low (<E-20) calibration
constants. Other errors may be abnormal times/dates and
abnormally high measurement sequence number in the RIT
file. Usually SeaStar will come up with a warning if the
calibration constants or time/date is not normal. If the RIT
shows signs of these error, please request record backup
file (RBD) from Star-Odd..

4. If the recorder has been measuring data, try to retrieve the
data ‘Recorder — Retrieve Data’. [If data can not be
retrieved there is fault with the PC com port, the
Communication Box /cable, or the recorder. If data
retrieval was ok, continue to step 5.
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5.

Make a short measurement test and start the recorder in a
new measurement sequence ‘Recorder — Start New
Measurment Sequence’.

Enable the CRC check ‘Settings — Connection’.

Connect to the recorder after the short measurement test,
‘Recorder — Connect’. [f a communication/CRC error
occurs,

then there is fault with the PC com port, the
Communication Box /cable, or the recorder.

Retrieve data from the short test ‘Recorder — Retrieve
Data’. Analyse the data, and verify that the values are
correct.

Starting a new measurement sequence

Communication errors
1. Timeout on command echo (no response from recorder).
a) Check if the voltage selection on the AC/DC adaptor is set to

9V or higher.

b) This may happen because the recorder has moved in the

hole, or has been removed (and inserted again into the hole).
The recorder is off-line. Please try to connect again.

2. Other communication errors.
Other communications problems can occur, but the recorder is still
on-line. The user is prompted to try starting the recorder again in a
new measurement sequence. [f the user chooses to connect to the
recorder again, a CRC error will most likely occur. In that case, the
user should disable the CRC check (Settings — Connection).

Retrieving data

Communication errors

1. No data retrieved.
This is likely to happen due to the battery is dead, or has failed. The
recorder has therefore not taken measurements. To verify if the
battery is dead, the following can be carried out:

a) Insert the recorder into the box, so that all lights are on.

b) In SeaStar, choose ‘Settings — Communications — Serial Ports’ and
set the ‘Port Enable/Power’ to be OFF. Before pressing the OK
button, watch the yellow and green lights carefully:
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a) Press OK. If the green light goes off ca. two seconds later
than the yellow light, there is still battery life remaining.

b) If the green and yellow lights go off at the same time when the
OK button is pressed, the battery is dead.

But remember that after these steps, you have to go back to ‘Settings —
Communications — Serial Ports’ and set the ‘Port Enable/Power’ to be
ON. That way you can only get all the lights back on.

2. Timeout on command echo.
There is no response from recorder. This may happen because the
recorder has moved in the hole, or has been removed (and inserted
again into the hole). The recorder is off-line. Please try to connect
again and retrieve data.

3. Other communication errors while retrieving data.
The result of the retrieval can be viewed in the .MIT file. Usually, if
the communication is in order, and all the data is retrieved correctly,
SeaStar will automaticlly convert the data from the decimal values
(.DAD), to the unit values (*.DAT). If this is not the case, then
SeaStar may drop the conversion part, and it is up to the user, to
either retrieve the data again, or manually convert the data (see
chapter 10), depending on the status of the retrieval. If a
communication error occurs in the middle of data retrieval, the
recorder becomes off-line. The user must connect to the recorder
again, and retrieve the data again.

4. Communication errors while updating recorder status.
In the event when communication error occurs while updating the
status in the recorder, i.e. after retriving the data, the CRC register
in the recorder is probably corrupt. Thus when connecting again to
the recorder, a CRC error will likely occur. If so, please disable
CRC check as described under ‘CRC error’ earlier in the appendix.

Graph and data table not displayed

If the software has not been installed from the CD, and only the
‘seastar.exe’ file is running, the graph and data table will not appear. This
may be the case when the user has a new computer, and gets the latest
version of SeaStar from Star-Oddi, runs only the ‘seastar.exe’ file, and has
not previously installed SeaStar from the CD. The software must be
installed from the CD (by running the ‘setup.exe’ file), because it installs
the package for creating the graphs and tables. The ‘seastar.exe’ file can
be updated later with a new ‘seastar.exe’ file.
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When data is retrieved using the ‘seastar.exe’ file only, the data is
retrieved OK, although the graph and table will not display. The data can
be opened in Excel, or viewed after installing the software from the CD.

Windows Settings

Windows XP

Graph not displayed in SeaStar

SeaStar may retrieve the data, create the DAT file but come with a
message indicating an error reading the DAT file, and graph not displayed.
This may be caused by a user setting feature in Windows XP. The user
has to be set as an administrative in order to view the data graphically in
SeaStar. The user accounts can be viewed and possibly changed by
performing the following:

B Control Panel

Fle Edt Vew Favortes Took Help I
Qo - © - F | Oseorth [ roisers | [T
crress | Contral Panel v B
D w85 Q9 F
E-’ Control Panel % . —
Accessibilty AddHardwsre  Addor  Administrative Adobe Gamma  Automatic BDE
@ switchto Category Yiew Options Remov... Tooks Updates  Administrator
= P @ # » O
See Also : g LJ “
Broadcom  Date andTme  Display  Folder Options  Fonts Game  Intel(R) GMA
& ‘Windows Update Cantral Suite 2 Controllers Driver

@) Help and Support

|||||

Go to ‘Control Panel’ and double click on ‘User Accounts’

-% User Accounts
Qe © 88rone
Learn About

;‘- User Accounts
v

2] User accounts
2] User account types

2] switching users Pick a task...
Chanage an account
Create a new account

Change the way users log on or off

or pick an account to change

Baldur S Guest
Computer administrator @ Guest account s off
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Choose ‘Change an account’.

Pick your account. If you are already set as ‘Computer administrator’,
please stop here and exit all windows. Otherwise continue by clicking on
your account.

-2 User Accounts |:”E”X|
e Back @ ﬂ Hame

Related Tasks

What do you want to change about your
Manage my network passwords
Prevent a forgotten password accoun t‘?

Change another account

Create a new account Change my name Baldur S
Computer administrator
Learn About

Create a password

@ Deleting your own account

@ Switching users Change my picture
@ Using a .MET Passpork

Change my account type

Change my .MET Passpart

If you are not set as ‘Computer administrator’, choose ‘Change my
account type’.

Enable the ‘Computer administrator’.

-2 User Accounts |:||§”X|

Learn About .
@ einne Pick a new account type

‘fou must assign another user on this computer with a computer administrator account before you
can change this user's account type, This ensures that there is always at least one user with a
computer administrator account on this computer,

With a computer administrator account, you can:
® Create, change, and delete accounts
» Make system-wide changes
» Install programs and access all files

Change Account Type
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Windows Vista

e reree L ==
Compatibilty | Secury | Details

ff you have problems with this program and it worked comecthy on
an earier version of Windows, select the compatibility mode that
matches that eadier version.

Compatibility mode

[]%Fun this program in compatibilite mode for:

Windows XP {Service Pack 2]

Settings
[] Fun in 256 colors
[T Run in 640 x 480 screen resolution
[7] Disable visual themes
[ Disable desktop composition
["] Disable display scaling on high DP| settings

Privilege Level

Run this program as an administrator

[ @Showseﬂingsforallusers l

[ ok || Cance || toply

The same problem as described for Windows XP can occur in Windows
Vista. To run the program as an administrator you will have to do
following: Right-click on the SeaStar icon and select ,Properties’. Click on
the ,Compatibility’ tab and you will see following:

Under section ,Privilege Level' check ,Run this program as an
administrator’, click Apply and OK.
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